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Notice

While reasonable efforts have been made to ensure that the
information in this document is complete and accurate at the time of
printing, Avaya assumes no liability for any errors. Avaya reserves
the right to make changes and corrections to the information in this
document without the obligation to notify any person or organization
of such changes.

Documentation disclaimer

“Documentation” means information published in varying mediums
which may include product information, operating instructions and
performance specifications that are generally made available to users
of products. Documentation does not include marketing materials.
Avaya shall not be responsible for any modifications, additions, or
deletions to the original published version of Documentation unless
such modifications, additions, or deletions were performed by or on
the express behalf of Avaya. End User agrees to indemnify and hold
harmless Avaya, Avaya's agents, servants and employees against all
claims, lawsuits, demands and judgments arising out of, or in
connection with, subsequent modifications, additions or deletions to
this documentation, to the extent made by End User.

Link disclaimer

Avaya is not responsible for the contents or reliability of any linked
websites referenced within this site or Documentation provided by
Avaya. Avaya is not responsible for the accuracy of any information,
statement or content provided on these sites and does not
necessarily endorse the products, services, or information described
or offered within them. Avaya does not guarantee that these links will
work all the time and has no control over the availability of the linked
pages.

Warranty

Avaya provides a limited warranty on Avaya hardware and software.
Refer to your sales agreement to establish the terms of the limited
warranty. In addition, Avaya’s standard warranty language, as well as
information regarding support for this product while under warranty is
available to Avaya customers and other parties through the Avaya
Support website: https://support.avaya.com/helpcenter/
getGenericDetails?detailld=C20091120112456651010 under the link
“Warranty & Product Lifecycle” or such successor site as designated
by Avaya. Please note that if You acquired the product(s) from an
authorized Avaya Channel Partner outside of the United States and
Canada, the warranty is provided to You by said Avaya Channel
Partner and not by Avaya.

“Hosted Service” means an Avaya hosted service subscription that
You acquire from either Avaya or an authorized Avaya Channel
Partner (as applicable) and which is described further in Hosted SAS
or other service description documentation regarding the applicable
hosted service. If You purchase a Hosted Service subscription, the
foregoing limited warranty may not apply but You may be entitled to
support services in connection with the Hosted Service as described
further in your service description documents for the applicable
Hosted Service. Contact Avaya or Avaya Channel Partner (as
applicable) for more information.

Hosted Service

THE FOLLOWING APPLIES ONLY IF YOU PURCHASE AN AVAYA
HOSTED SERVICE SUBSCRIPTION FROM AVAYA OR AN AVAYA
CHANNEL PARTNER (AS APPLICABLE), THE TERMS OF USE
FOR HOSTED SERVICES ARE AVAILABLE ON THE AVAYA
WEBSITE, HTTPS://SUPPORT.AVAYA.COM/LICENSEINFO UNDER
THE LINK “Avaya Terms of Use for Hosted Services” OR SUCH
SUCCESSOR SITE AS DESIGNATED BY AVAYA, AND ARE
APPLICABLE TO ANYONE WHO ACCESSES OR USES THE
HOSTED SERVICE. BY ACCESSING OR USING THE HOSTED
SERVICE, OR AUTHORIZING OTHERS TO DO SO, YOU, ON
BEHALF OF YOURSELF AND THE ENTITY FOR WHOM YOU ARE
DOING SO (HEREINAFTER REFERRED TO INTERCHANGEABLY
AS “YOU” AND “END USER”), AGREE TO THE TERMS OF USE. IF
YOU ARE ACCEPTING THE TERMS OF USE ON BEHALF A
COMPANY OR OTHER LEGAL ENTITY, YOU REPRESENT THAT
YOU HAVE THE AUTHORITY TO BIND SUCH ENTITY TO THESE
TERMS OF USE. IF YOU DO NOT HAVE SUCH AUTHORITY, OR IF

YOU DO NOT WISH TO ACCEPT THESE TERMS OF USE, YOU
MUST NOT ACCESS OR USE THE HOSTED SERVICE OR
AUTHORIZE ANYONE TO ACCESS OR USE THE HOSTED
SERVICE.

Licenses

THE SOFTWARE LICENSE TERMS AVAILABLE ON THE AVAYA
WEBSITE, HTTPS://SUPPORT.AVAYA.COM/LICENSEINFO,
UNDER THE LINK “AVAYA SOFTWARE LICENSE TERMS (Avaya
Products)” OR SUCH SUCCESSOR SITE AS DESIGNATED BY
AVAYA, ARE APPLICABLE TO ANYONE WHO DOWNLOADS,
USES AND/OR INSTALLS AVAYA SOFTWARE, PURCHASED
FROM AVAYA INC., ANY AVAYA AFFILIATE, OR AN AVAYA
CHANNEL PARTNER (AS APPLICABLE) UNDER A COMMERCIAL
AGREEMENT WITH AVAYA OR AN AVAYA CHANNEL PARTNER.
UNLESS OTHERWISE AGREED TO BY AVAYA IN WRITING,
AVAYA DOES NOT EXTEND THIS LICENSE IF THE SOFTWARE
WAS OBTAINED FROM ANYONE OTHER THAN AVAYA, AN AVAYA
AFFILIATE OR AN AVAYA CHANNEL PARTNER; AVAYA
RESERVES THE RIGHT TO TAKE LEGAL ACTION AGAINST YOU
AND ANYONE ELSE USING OR SELLING THE SOFTWARE
WITHOUT A LICENSE. BY INSTALLING, DOWNLOADING OR
USING THE SOFTWARE, OR AUTHORIZING OTHERS TO DO SO,
YOU, ON BEHALF OF YOURSELF AND THE ENTITY FOR WHOM
YOU ARE INSTALLING, DOWNLOADING OR USING THE
SOFTWARE (HEREINAFTER REFERRED TO
INTERCHANGEABLY AS “YOU” AND “END USER”), AGREE TO
THESE TERMS AND CONDITIONS AND CREATE A BINDING
CONTRACT BETWEEN YOU AND AVAYA INC. OR THE
APPLICABLE AVAYA AFFILIATE (“AVAYA”).

Avaya grants You a license within the scope of the license types
described below, with the exception of Heritage Nortel Software, for
which the scope of the license is detailed below. Where the order
documentation does not expressly identify a license type, the
applicable license will be a Designated System License as set forth
below in the Designated System(s) License (DS) section as
applicable. The applicable number of licenses and units of capacity
for which the license is granted will be one (1), unless a different
number of licenses or units of capacity is specified in the
documentation or other materials available to You. “Software” means
computer programs in object code, provided by Avaya or an Avaya
Channel Partner, whether as stand-alone products, pre-installed on
hardware products, and any upgrades, updates, patches, bug fixes,
or modified versions thereto. “Designated Processor” means a single
stand-alone computing device. “Server” means a set of Designated
Processors that hosts (physically or virtually) a software application
to be accessed by multiple users. “Instance” means a single copy of
the Software executing at a particular time: (i) on one physical
machine; or (ii) on one deployed software virtual machine (“VM”) or
similar deployment.

Licence types

Designated System(s) License (DS). End User may install and use
each copy or an Instance of the Software only: 1) on a number of
Designated Processors up to the number indicated in the order; or 2)
up to the number of Instances of the Software as indicated in the
order, Documentation, or as authorized by Avaya in writing. Avaya
may require the Designated Processor(s) to be identified in the order
by type, serial number, feature key, Instance, location or other
specific designation, or to be provided by End User to Avaya through
electronic means established by Avaya specifically for this purpose.

Concurrent User License (CU). End User may install and use the
Software on multiple Designated Processors or one or more Servers,
so long as only the licensed number of Units are accessing and using
the Software at any given time. A “Unit” means the unit on which
Avaya, at its sole discretion, bases the pricing of its licenses and can
be, without limitation, an agent, port or user, an e-mail or voice mail
account in the name of a person or corporate function (e.g.,
webmaster or helpdesk), or a directory entry in the administrative
database utilized by the Software that permits one user to interface
with the Software. Units may be linked to a specific, identified Server
or an Instance of the Software.

Named User License (NU). You may: (i) install and use each copy or
Instance of the Software on a single Designated Processor or Server
per authorized Named User (defined below); or (ii) install and use
each copy or Instance of the Software on a Server so long as only
authorized Named Users access and use the Software. “Named


https://support.avaya.com/helpcenter/getGenericDetails?detailId=C20091120112456651010
https://support.avaya.com/helpcenter/getGenericDetails?detailId=C20091120112456651010
https://support.avaya.com/LicenseInfo
https://support.avaya.com/LicenseInfo

User”, means a user or device that has been expressly authorized by
Avaya to access and use the Software. At Avaya’s sole discretion, a
“Named User” may be, without limitation, designated by name,
corporate function (e.g., webmaster or helpdesk), an e-mail or voice
mail account in the name of a person or corporate function, or a
directory entry in the administrative database utilized by the Software
that permits one user to interface with the Software.

Shrinkwrap License (SR). You may install and use the Software in
accordance with the terms and conditions of the applicable license
agreements, such as “shrinkwrap” or “clickthrough” license
accompanying or applicable to the Software (“Shrinkwrap License”).

Heritage Nortel Software

“Heritage Nortel Software” means the software that was acquired by
Avaya as part of its purchase of the Nortel Enterprise Solutions
Business in December 2009. The Heritage Nortel Software is the
software contained within the list of Heritage Nortel Products located
at https://support.avaya.com/Licenselnfo under the link “Heritage
Nortel Products” or such successor site as designated by Avaya. For
Heritage Nortel Software, Avaya grants Customer a license to use
Heritage Nortel Software provided hereunder solely to the extent of
the authorized activation or authorized usage level, solely for the
purpose specified in the Documentation, and solely as embedded in,
for execution on, or for communication with Avaya equipment.
Charges for Heritage Nortel Software may be based on extent of
activation or use authorized as specified in an order or invoice.

Copyright

Except where expressly stated otherwise, no use should be made of
materials on this site, the Documentation, Software, Hosted Service,
or hardware provided by Avaya. All content on this site, the
documentation, Hosted Service, and the product provided by Avaya
including the selection, arrangement and design of the content is
owned either by Avaya or its licensors and is protected by copyright
and other intellectual property laws including the sui generis rights
relating to the protection of databases. You may not modify, copy,
reproduce, republish, upload, post, transmit or distribute in any way
any content, in whole or in part, including any code and software
unless expressly authorized by Avaya. Unauthorized reproduction,
transmission, dissemination, storage, and or use without the express
written consent of Avaya can be a criminal, as well as a civil offense
under the applicable law.

Virtualization

The following applies if the product is deployed on a virtual machine.
Each product has its own ordering code and license types. Unless
otherwise stated, each Instance of a product must be separately
licensed and ordered. For example, if the end user customer or
Avaya Channel Partner would like to install two Instances of the
same type of products, then two products of that type must be
ordered.

Third Party Components

“Third Party Components” mean certain software programs or
portions thereof included in the Software or Hosted Service may
contain software (including open source software) distributed under
third party agreements (“Third Party Components”), which contain
terms regarding the rights to use certain portions of the Software
(“Third Party Terms”). As required, information regarding distributed
Linux OS source code (for those products that have distributed Linux
OS source code) and identifying the copyright holders of the Third
Party Components and the Third Party Terms that apply is available
in the products, Documentation or on Avaya’s website at: https://
support.avaya.com/Copyright or such successor site as designated
by Avaya. The open source software license terms provided as Third
Party Terms are consistent with the license rights granted in these
Software License Terms, and may contain additional rights benefiting
You, such as modification and distribution of the open source
software. The Third Party Terms shall take precedence over these
Software License Terms, solely with respect to the applicable Third
Party Components to the extent that these Software License Terms
impose greater restrictions on You than the applicable Third Party
Terms.

The following applies only if the H.264 (AVC) codec is distributed with
the product. THIS PRODUCT IS LICENSED UNDER THE AVC
PATENT PORTFOLIO LICENSE FOR THE PERSONAL USE OF A
CONSUMER OR OTHER USES IN WHICH IT DOES NOT RECEIVE

REMUNERATION TO (i) ENCODE VIDEO IN COMPLIANCE WITH
THE AVC STANDARD (“AVC VIDEO”) AND/OR (ii) DECODE AVC
VIDEO THAT WAS ENCODED BY A CONSUMER ENGAGED IN A
PERSONAL ACTIVITY AND/OR WAS OBTAINED FROM A VIDEO
PROVIDER LICENSED TO PROVIDE AVC VIDEO. NO LICENSE IS
GRANTED OR SHALL BE IMPLIED FOR ANY OTHER USE.
ADDITIONAL INFORMATION MAY BE OBTAINED FROM MPEG LA,
L.L.C. SEE HTTP://WWW.MPEGLA.COM.

Service Provider

THE FOLLOWING APPLIES TO AVAYA CHANNEL PARTNER’S
HOSTING OF AVAYA PRODUCTS OR SERVICES. THE PRODUCT
OR HOSTED SERVICE MAY USE THIRD PARTY COMPONENTS
SUBJECT TO THIRD PARTY TERMS AND REQUIRE A SERVICE
PROVIDER TO BE INDEPENDENTLY LICENSED DIRECTLY FROM
THE THIRD PARTY SUPPLIER. AN AVAYA CHANNEL PARTNER’S
HOSTING OF AVAYA PRODUCTS MUST BE AUTHORIZED IN
WRITING BY AVAYA AND IF THOSE HOSTED PRODUCTS USE
OR EMBED CERTAIN THIRD PARTY SOFTWARE, INCLUDING
BUT NOT LIMITED TO MICROSOFT SOFTWARE OR CODECS,
THE AVAYA CHANNEL PARTNER IS REQUIRED TO
INDEPENDENTLY OBTAIN ANY APPLICABLE LICENSE
AGREEMENTS, AT THE AVAYA CHANNEL PARTNER’S EXPENSE,
DIRECTLY FROM THE APPLICABLE THIRD PARTY SUPPLIER.

WITH RESPECT TO CODECS, IF THE AVAYA CHANNEL
PARTNER IS HOSTING ANY PRODUCTS THAT USE OR EMBED
THE H.264 CODEC OR H.265 CODEC, THE AVAYA CHANNEL
PARTNER ACKNOWLEDGES AND AGREES THE AVAYA
CHANNEL PARTNER IS RESPONSIBLE FOR ANY AND ALL
RELATED FEES AND/OR ROYALTIES. THE H.264 (AVC) CODEC
IS LICENSED UNDER THE AVC PATENT PORTFOLIO LICENSE
FOR THE PERSONAL USE OF A CONSUMER OR OTHER USES
IN WHICH IT DOES NOT RECEIVE REMUNERATION TO: (1)
ENCODE VIDEO IN COMPLIANCE WITH THE AVC STANDARD
(“AVC VIDEO”) AND/OR (Il) DECODE AVC VIDEO THAT WAS
ENCODED BY A CONSUMER ENGAGED IN A PERSONAL
ACTIVITY AND/OR WAS OBTAINED FROM A VIDEO PROVIDER
LICENSED TO PROVIDE AVC VIDEO. NO LICENSE IS GRANTED
OR SHALL BE IMPLIED FOR ANY OTHER USE. ADDITIONAL
INFORMATION FOR H.264 (AVC) AND H.265 (HEVC) CODECS
MAY BE OBTAINED FROM MPEG LA, L.L.C. SEE HTTP://
WWW.MPEGLA.COM.

Compliance with Laws

You acknowledge and agree that it is Your responsibility for
complying with any applicable laws and regulations, including, but not
limited to laws and regulations related to call recording, data privacy,
intellectual property, trade secret, fraud, and music performance
rights, in the country or territory where the Avaya product is used.

Preventing Toll Fraud

“Toll Fraud” is the unauthorized use of your telecommunications
system by an unauthorized party (for example, a person who is not a
corporate employee, agent, subcontractor, or is not working on your
company's behalf). Be aware that there can be a risk of Toll Fraud
associated with your system and that, if Toll Fraud occurs, it can
result in substantial additional charges for your telecommunications
services.

Avaya Toll Fraud intervention

If You suspect that You are being victimized by Toll Fraud and You
need technical assistance or support, call Technical Service Center
Toll Fraud Intervention Hotline at +1-800-643-2353 for the United
States and Canada. For additional support telephone numbers, see
the Avaya Support website: https://support.avaya.com or such
successor site as designated by Avaya.

Security Vulnerabilities

Information about Avaya’s security support policies can be found in
the Security Policies and Support section of https://
support.avaya.com/security.

Suspected Avaya product security vulnerabilities are handled per the
Avaya Product Security Support Flow (https:/
support.avaya.com/css/P8/documents/100161515).



https://support.avaya.com/LicenseInfo
https://support.avaya.com/Copyright
https://support.avaya.com/Copyright
HTTP://WWW.MPEGLA.COM
HTTP://WWW.MPEGLA.COM
HTTP://WWW.MPEGLA.COM
https://support.avaya.com
https://support.avaya.com/security
https://support.avaya.com/security
https://support.avaya.com/css/P8/documents/100161515
https://support.avaya.com/css/P8/documents/100161515

Downloading Documentation

For the most current versions of Documentation, see the Avaya
Support website: https://support.avaya.com, or such successor site
as designated by Avaya.

Contact Avaya Support

See the Avaya Support website: https://support.avaya.com for
product or Hosted Service notices and articles, or to report a problem
with your Avaya product or Hosted Service. For a list of support
telephone numbers and contact addresses, go to the Avaya Support
website: https://support.avaya.com (or such successor site as
designated by Avaya), scroll to the bottom of the page, and select
Contact Avaya Support.

Trademarks

The trademarks, logos and service marks (“Marks”) displayed in this
site, the Documentation, Hosted Service(s), and product(s) provided
by Avaya are the registered or unregistered Marks of Avaya, its
affiliates, its licensors, its suppliers, or other third parties. Users are
not permitted to use such Marks without prior written consent from
Avaya or such third party which may own the Mark. Nothing
contained in this site, the Documentation, Hosted Service(s) and
product(s) should be construed as granting, by implication, estoppel,
or otherwise, any license or right in and to the Marks without the
express written permission of Avaya or the applicable third party.

Avaya is a registered trademark of Avaya Inc.

All non-Avaya trademarks are the property of their respective owners.
Linux® is the registered trademark of Linus Torvalds in the U.S. and
other countries.
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Chapter 1: Introduction

Purpose

This document describes how to use Avaya Aura® Messaging features.

This document is intended for people who want to learn how to use Messaging features.

Change history

Issue Date

Summary of changes

4 April 2020

» Updated information about supported web browsers and added
information about web browsers that support HTMLS5 to

Requirements on page 34.

» Updated the description for the Start recording button in Reply
field descriptions on page 43, Forward page descriptions on
page 45, Compose New Message field descriptions on page 47,
and Compose Login Announcement field descriptions on
page 49.

3 September 2018

» Updated Logging in to Messaging Web Access on page 35.

* Minor rephrasing throughout the document.

2 December 2017

Removed support for the following servers:
+ Dell™ PowerEdge™ R610

* HP ProLiant DL360 G7

+ CallPilot 1006r

April 2020
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Introduction

Issue Date Summary of changes

1 October 2016 Added information about the following product enhancements:

» Windows 10 and Edge browser support for User Preferences and
Messaging Web Access.

» Windows 10 support for Fax desktop client.
* Greeting rules.
» System requirements for Fax.

* Messaging Web Access user behavior when Avaya message store
is offline.

¢ Password rules.

» Record and send Login announcements.

Support

Go to the Avaya Support website at https://support.avaya.com for the most up-to-date
documentation, product notices, and knowledge articles. You can also search for release notes,
downloads, and resolutions to issues. Use the online service request system to create a service
request. Chat with live agents to get answers to questions, or request an agent to connect you to a
support team if an issue requires additional expertise.
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Chapter 2: Setting up the Avaya Aura®
Messaging Mailbox

Avaya Aura® Messaging

With Avaya Aura® Messaging, you can manage your calls, voice messages, and fax messages on
any device including tablets, smart phones, deskphones, and computers. Messaging offers an
intuitive interface and a rich set of features for users to enhance productivity. Messaging provides
the required flexibility, resilience, and scale to fit into demanding environments.

Messaging supports the following subscriber interfaces:

Interface type Interface

Desktop Microsoft Outlook email client

Outbound Fax Client

Telephone User Interface Aria

Audix

CallPilot

Teletypewriter (TTY)

Web-based interface Messaging Web Access

User Preferences

Supported browser for web-based interface
The web-based interfaces support the following web browsers:
+ Microsoft® Windows® Internet Explorer 9 or later
* Mozilla Firefox 30 or later
» Google Chrome 35 or later
» Apple Safari 6 or later
+ Microsoft® Edge
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Setting up the Avaya Aura® Messaging Mailbox

Prerequisites to set up a Messaging mailbox

Get the following information from the administrator:
* The Messaging access numbers.
- Internal
- External
The Messaging mailbox number and a temporary password.
* The URL to gain access to the Messaging User Preferences webpage.

* The URL to gain access to Messaging Web Access.

Messaging mailbox access

Accessing Messaging mailbox from an external phone
Before you begin
Get the external Messaging access number from the administrator.
Procedure
1. Dial the external Messaging access number and press the pound key (#).
The system prompts you to enter your Messaging mailbox number.

2. Enter your Messaging mailbox number, and press the pound key (#).

The system announces your name and prompts you to enter your password.

3. Enter your password, and press the pound key (#).

Accessing Messaging mailbox from a phone of another
Messaging user of the same organization

Before you begin
Get the internal Messaging access number from the administrator.
Procedure

1. Dial the internal Messaging access number.
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Comments on this document? infodev@avaya.com

12


mailto:infodev@avaya.com?subject=Using Avaya Aura®‎‎ Messaging

Messaging mailbox access

2. Do one of the following:
* If you are an Aria or Audix user, press star (*).

* If you are a CallPilot user, when the system prompts you to enter your password, press
the pound key (#) .

Pressing the pound key (#) restarts the login process and prompts you to enter a
different mailbox number.

3. Enter your Messaging mailbox number, and press the pound key (#).
The system announces your name and prompts you to enter your password.

4. Enter your password, and press the pound key (#).

Accessing Messaging mailbox from a phone by dialing
Automated Attendant number
Before you begin
Get the Automated Attendant number from the administrator.
Procedure
1. Dial the Automated Attendant number of your organization, and press the pound key (#).
2. Enter your Messaging mailbox number, and press the pound key (#).
The system announces your name and prompts you to enter your password.

3. Enter your password, and press the pound key (#).

Accessing Messaging mailbox from your desk phone or soft
phone

Before you begin

Get the internal Messaging access number from the administrator.

Procedure

1. Perform one of the following:
* Press the Voice mail or Message button.
* Dial the internal Messaging access number.
The system announces your name and prompts you to enter your password.

2. Enter your password, and press the pound key (#).
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Setting up the Avaya Aura® Messaging Mailbox

Messaging mailbox initialization
To start receiving voice mails, you must initialize your Messaging mailbox using a TUI.
The mailbox initialization process depends on:
» The TUI that your administrator configured for your mailbox and your user account.

For more information about the TUI prompts to record your name or a personal greeting or
both, see the TUI Quick Reference.

* The value of the system settings that your administrator sets for your mailbox and your user
account.

Mailbox initialization involves:
» Changing your temporary password.

* Recording your name: Messaging uses your recorded name to identify you to other
Messaging users. The system also uses your recorded name in the system-generated
greeting that TUI plays when callers reach your mailbox. If your organization uses the
Messaging automatic attendant, TUI plays your recorded name before the attendant transfers
callers to your extension. If you do not record your name, TUI plays the Text-to-Speech (TTS)
version of your name.

* Recording your personal greeting: Messaging plays greeting to callers when your phone is
busy or you do not answer a call. If you do not record personal greetings, the TUI plays the
system-generated greeting with embedded recorded name. If you do not record your name or
a personal greeting, TUI plays the TTS version of your name.

If you initialized your mailbox earlier, but cannot log in, get a temporary password from the
administrator.

Initializing your Messaging mailbox

Before you begin
Ensure that the administrator configured the settings for your mailbox.
Procedure

1. Call Messaging using a TUI.

2. Enter your temporary password that the administrator assigns to you while creating your
mailbox, and press the pound key (#).

If you changed your temporary password on the Password page in User Preferences, use
your new password or follow the prompts.

3. (Optional) Follow the prompts to change your password.
4. (Optional) Follow the prompts to record your name.

If the administrator configured Messaging to prevent sending messages to uninitialized
mailboxes, you can perform this step later.
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Messaging mailbox initialization

5. (Optional) Follow the prompts to record your personal greeting.

If the administrator configured Messaging to prevent sending messages to uninitialized
mailboxes, you can perform this step later.

April 2020 Using Avaya Aura® Messaging 15

Comments on this document? infodev@avaya.com



mailto:infodev@avaya.com?subject=Using Avaya Aura®‎‎ Messaging

Chapter 3: Navigation

This chapter describes the menus, buttons, and icons of web-based user interfaces of Messaging.

User Preferences

Menus

Name Description

General To view and customize your general Messaging mailbox preferences.

Reach Me To customize how callers connect with you in any of the following
situations:
* You do not answer a call.
* Your primary extension is busy.
Messaging plays a prerecorded message to callers when forwarding calls
to alternate phone numbers.

Notify Me To send you a notification when you receive a new voice message.

My Phone To customize your preferences when using the telephone user interface.

Personal Lists

To create multiple personal lists and add users as members in the lists to
send a voice message to multiple recipients simultaneously

Enhanced Lists

To add and delete members of enhanced lists defined by the system
administrator.

Greetings To customize the greetings including prerecorded names and messages
that the TUls play to the callers when a call reaches your voice mail.
Password To modify the Messaging password.
Advanced To reset the association between your Messaging mailbox and your email
identity.
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Messaging Web Access

Buttons
Button Description
Save Saves the changes.
Log Out Signs you out of the Messaging User Preferences.
Help Opens the associated help file.

Messaging Web Access

Menus
Name Description
Messages To compose and forward, listen and reply to, and delete voice messages.
You can also call the sender of the voice message.
Preferences To customize your Messaging mailbox preferences.
Icons

Icon Name Description

> Flag Displays the voice message tags,
such as Broadcast message or
Login announcement (), Private
(&), or Important ( 4).

Sorts the messages based on
tagged or untagged.

a Private Identifies a private message.

A Important Identifies an important message.

: Broadcast message or Login Identifies a broadcast message or
announcement login announcement.

2 Auto delete Identifies a message that is
scheduled to be deleted after a
specified time.

[ Select all Selects all the listed voice
messages.
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Navigation

Icon Name Description
] Select Select a particular voice message
from the list.
Buttons

Button Description

Messages Displays the Messaging Web Access Messages page and a list of voice
messages.

Preferences Displays the Avaya Aura® Messaging User Preferences page to
customize the settings of your Messaging account.

Compose Records a new voice message to send to the appropriate people.

Login announcement

Records and sends a message that appears in each mailbox. The
administrator must enable the Login announcement feature for your
mailbox.

Reply Records and sends a reply voice message to the sender of a voice
message.

Reply all Records and sends a reply voice message to all addressees of a voice
message.

Forward Forwards a voice message to other people. You can also record and send

a new message with a forwarded message.

Play message

Plays a voice message. You can specify whether you want to play a
message using computer or telephone.

Call sender Calls the sender of a voice message.
Delete Deletes a voice message.
Log out Signs you out of Messaging Web Access.
Help Opens the associated help file.
Using Avaya Aura® Messaging 18
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Chapter 4: Operation

You can access your Messaging mailbox and perform various operations using:
* Microsoft Outlook email client
* Telephone user interface
* Messaging Web Access
* Fax
» Teletypewriter

Microsoft Outlook email client

You can configure your Microsoft Outlook account to gain access to your voice messages. After
configuring your Outlook account, Microsoft Outlook displays the Messaging toolbar for the
received voice messages.

Email client (Outlook) configuration

Messaging supports the following message stores:
* The Avaya message store
» The Exchange server

To gain access to the voice messages, you must configure Microsoft Outlook based on the
message store that you use.

* To configure Microsoft Outlook for Avaya message store, set up an IMAP email account in
your Outlook to use voice messages.

The procedures to configure Microsoft Outlook for Avaya message store depend on the
Outlook version.

- Configuring Outlook 2013 for Avaya message store on page 20.

- Configuring Outlook 2010 for Avaya message store on page 21.

- Configuring Outlook 2007 for Avaya message store on page 23.

» To configure Microsoft Outlook for Exchange server message store, you can directly use your
designated email account in Microsoft Outlook without any further configuration, to gain
access to the voice messages.
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Operation

© Note:

The Microsoft Outlook toolbar does not display the messages delivered before the mailbox
configuration in Outlook.

Configuring Outlook 2013 for Avaya message store

Before you begin

Follow this procedure only if the Messaging store type (provided by your administrator) is Avaya
message store. This procedure is not applicable if the Messaging store type is Exchange server.

About this task
To configure Microsoft Office Outlook 2013, perform the following steps:

Procedure

1.
2.

Start Outlook.
On the File menu, click Info and then click Add Account.

You must create a default Outlook profile and load the default profile in Microsoft Office
Outlook 2013 otherwise, Outlook window closes automatically.

The system displays the Auto Account Setup dialog box.

. Select the Manual setup of additional server types option, and then click Next.

The system displays the Choose Service dialog box.

. Select the POP or IMAP option, and then click Next.

The system displays the POP and IMAP Account Settings dialog box.

5. In the Your Name box, type your name, for example Michael J. Smith.

6. In the E-mail Address box, type the email address that you use for your Avaya message

10.

April 2020

store.
In the Server Information section, select IMAP for Account Types.

In the Incoming mail server box, type the Messaging server address provided by your
administrator.

In the Outgoing mail server (SMTP) box, type the name of your Messaging server
address provided by your administrator. This is the same server as mentioned at the
previous step.

© Note:

The Outgoing mail server (SMTP) is to be used by Messaging only. Do not send
emails using this account. To send emails, use your designated email account. To reply
to voice messages or to forward them, use the Messaging toolbar.

In the User Name box, type your assigned internal identifier.

For example, fName.IName.112233@FQDNOFAAMStorageServer. You must use the
entire local part fName.IName. 11223 till @ sign as user name for IMAP.
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1.
12.
13.

14.
15.

16.
17.
18.
19.
20.
21.

Microsoft Outlook email client

In the Password box, type your Messaging password.
Click More Settings....

On the General tab, replace the default name for the mail account with Avaya Aura
Messaging or a similar designation to indicate that this is your voice messages mailbox.

Click the Advanced tab.

Select Auto for Use the following type of encrypted connection for both Incoming and
Outgoing servers in the Server Port Numbers section.

Click the Outgoing Server tab.

Select the My outgoing server (SMTP) requires authentication check box.

Select the Use same settings as my incoming mail server option.

Click OK.

Click Next when you finish entering this configuration information, and then click Finish.

(Optional) You can also add your voice messages mailbox as a favorite folder by
performing the following steps:

a. In Outlook, click the mail folder.
b. To expand the folder, click the plus sign (+).

c. Right-click Inbox, and then select Add to Favorite Folders.

Configuring Outlook 2010 for Avaya message store

Before you begin

Follow this procedure only if the Messaging store type (provided by your administrator) is Avaya
message store. This procedure is not applicable if the Messaging store type is Exchange server.

About this task
To configure Microsoft Office Outlook 2010, perform the following steps:

Procedure

1.
2.

April 2020

Start Outlook.
On the File menu, click Info and then click Add Account.

You must create a default Outlook profile and load the default profile in Microsoft Office
Outlook 2010 otherwise, Outlook window closes automatically.

The system displays the Auto Account Setup dialog box.

. Select the Manually configure server settings or additional server types option, and

then click Next.
The system displays the Choose Service dialog box.
Select the Internet E-Mail check box, and then click Next.

The system displays the Internet E-mail Settings dialog box.
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Operation

5. In the Your Name box, type your name, for example Michael J. Smith.

10.

1.
12.
13.

14.
15.

16.
17.
18.
19.
20.
21.

April 2020

In the E-mail Address box, type the email address that you use for your Avaya message
store.

In the Server Information section, select IMAP for Account Types.

In the Incoming mail server box, type the Messaging server address provided by your
administrator.

In the Outgoing mail server (SMTP) box, type the name of your Messaging server
address provided by your administrator. This is the same server as mentioned at the
previous step.

© Note:

» The Outgoing mail server (SMTP) is to be used by Messaging only. Do not send
emails using this account. To send emails, use your designated email account.

* To reply to voice messages or to forward them, use the Messaging toolbar or right-
click on the voice message and click on the appropriate functions under Custom
Actions in the context-sensitive menu.

© Tip:

You must use the Outlook 2010 upgraded with latest SP2 for Office 2010 (32-bit), to
view the functions under Custom Actions in the context-sensitive menu.

In the User Name box, type your assigned internal identifier.

For example, fName.IName.112233@FQDNOFAAMStorageServer. You must use the
entire local part fName.IName. 11223 till @ sign as user name for IMAP.

In the Password box, type your Messaging password.
Click More Settings....

On the General tab, replace the default name for the mail account with Avaya Aura
Messaging or a similar designation to indicate that this is your voice messages mailbox.

Click the Advanced tab.

Select Auto for Use the following type of encrypted connection for both Incoming and
Outgoing servers in the Server Port Numbers section.

Click the Outgoing Server tab.

Select the My outgoing server (SMTP) requires authentication check box.

Select the Use same settings as my incoming mail server option.

Click OK.

Click Next when you finish entering this configuration information, and then click Finish.

(Optional) You can also add your voice messages mailbox as a favorite folder by
performing the following steps:

a. In Outlook, click the mail folder.
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Microsoft Outlook email client

b. To expand the folder, click the plus sign (+).

c. Right-click Inbox, and then select Add to Favorite Folders.

Configuring Outlook 2007 for Avaya message store

Before you begin

Follow this procedure only if the Messaging store type (provided by your administrator) is Avaya
message store. This procedure is not applicable if the Messaging store type is Exchange server.

Procedure

1.
2.

Start Outlook.
On the Tools menu, click Account Settings....

You must create a default Outlook profile and load the default profile in Microsoft Office
Outlook 2007 otherwise, Outlook window closes automatically.

On the E-mail tab, click New.

The system displays the Choose E-mail Service dialog box.

Select the Microsoft Exchange, POP3, IMAP, or HTTP option, and then click Next.
The system displays the Auto Account Setup dialog box.

. Select the Manually configure server settings or additional server types check box,

and then click Next.

The System displays the Choose E-mail Service dialog box.

. Select the Internet E-mail option, and then click Next.

The System displays the Internet E-mail Settings dialog box.

7. In the Your Name box, type your name, for example Michael J. Smith.

8. In the E-mail Address box, type the email address that you use for your Avaya message

1.

April 2020

store.

In the Server Information section, select IMAP for Account Types.

. In the Incoming mail server box, type the Messaging server address provided by your

administrator.

In the Outgoing mail server (SMTP) box, type the name of your Messaging server
address provided by your administrator. This is the same server as mentioned at the
previous step.

© Note:

* The Outgoing mail server (SMTP) is to be used by Messaging only. Do not send e-
mails using this account. To send e-mails, use your designated email account.

* To reply to voice messages or to forward them, use the Messaging toolbar or right-
click on the voice message and click on the appropriate functions under Custom
Actions in the context-sensitive menu.
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Operation

12

13.
14.
15.

16.

17.
18.
19.
20.
21.
22.

In the User Name box, type your assigned internal identifier.

For example, fName.IName.112233@FQDNOFAAMStorageServer. You must use the
entire local part fName.IName. 11223 till @ sign as user name for IMAP.

In the Password box, type your Messaging password.
Click More Settings....

On the General tab, replace the default name for the mail account with Avaya Aura
Messaging or a similar designation to indicate that this is your voice messages mailbox.

Select Auto for Use the following type of encrypted connection for both Incoming and
Outgoing servers in the Server Port Numbers section.

Click the Outgoing Server tab.

Select the My outgoing server (SMTP) requires authentication check box.

Select the Use same settings as my incoming mail server option.

Click OK.

Click Next when you finish entering this configuration information, and then click Finish.

(Optional) You can also add your voice messages mailbox as a favorite folder by
performing the following steps:

a. In Outlook, click the mail folder.
b. To expand the folder, click the plus sign (+).

c. Right-click Inbox, and then select Add to Favorite Folders.

The Messaging toolbar

The Messaging toolbar on the Outlook email client displays the following feature buttons to access
your voice messages:

* Play on PC
* Play on Phone

» Voice Reply

» Voice Forward
« Call Sender

» User Preferences

* Help

You can set up your Notify Me User Preferences to receive a notification email in your designated
inbox for each voice message you receive. However, Outlook email client does not display the
Messaging toolbar for the notification emails. The Messaging toolbar is available only for the
Messaging voice messages.

April 2020
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Microsoft Outlook email client

For the following features to work correctly, you must enable the web browser pop-ups for internal
web servers:

* Play on Phone
* Voice Reply
* Voice Forward
+ Call Sender

Play on PC

Use Play on PC to play a voice message on your computer.
Playing a voice message on personal computer
Before you begin
Ensure that your system has Windows Media Player 9 or later.
Procedure
1. On the Messaging toolbar, click Play on PC to open a voice message.
2. Perform one or more of the following:

* Use the Pause, Resume, Stop, Rewind, and Forward buttons to control playback. The
Rewind and Forward buttons either rewind or advance the message by 10 seconds.

» Adjust the volume on your computer speakers or headset as required.

Play on Phone
Use Play on Phone to listen to your voice message on a telephone.
Playing a voice message on phone for the first time

About this task

When you use Play on Phone for the first time, you must provide your Messaging mailbox number
to associate it with your email identity. You need to perform this task only once.

Procedure

1. In the Avaya Voice Message—Play on Phone window, in the Mailbox number field, type
your mailbox number.

2. Click Save.
Playing a voice message on phone
Before you begin

Ensure that you complete the task, Using Play on Phone for the first time on page 25 to associate
the Messaging mailbox number with your email identity.

Procedure

1. Open your voice message with your email client, and then navigate to the Avaya Voice
Message toolbar.
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Operation

2. To listen to a voice message from your inbox or from the Outlook mail folder, right-click the
voice message.

 For Outlook 2007: Click Play on Phone.
* For Outlook 2010, 2013: Click Custom Actions > Play on Phone.

The system displays the Phone number selection window unless you previously selected
Always use this phone number. See Step 3.

3. Select the phone that you want to use to play the message.
* Click Extension to use your extension.

* Click Mobile to use your mobile phone. You can choose this option if you enter a mobile
number on the Mobile Phone or Pager field on the User Preferences > General

page.
* Click Other to enter another number.

© Note:

Click Always use this phone number to always use the selected phone number for
Messaging toolbar feature operations. You may reset this option in the Play on Phone
section of the User Preferences > General page.

4. Click Call.
The system calls the selected number and displays the Call Progress window.
5. Answer the phone and enter your password at the prompt.

The system plays the voice message.

Voice Reply

Use Voice Reply to reply to voice messages received from users in your organization’s voice mail
system.

Sending a voice reply
Procedure

1. Use your email client to open your voice message and then navigate to the Messaging
toolbar.

2. Click Voice Reply.

The system displays the Phone number selection window (unless you previously
selected Always use this phone number. See step 3).

3. Select the phone you want to use to send a voice reply.
+ Select Extension to use your extension.

+ Select Mobile to use your mobile phone. You can choose this option only if your
administrator has populated the mobile phone field.
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Microsoft Outlook email client

 Select Other Mobile to use another mobile phone. You can choose this option if you
have entered a mobile number on the Other mobile phone or pager field on the User
Preferences > General page.

© Note:

Messaging supports only email based (SMTP) pager notifications.
» Select Other to manually enter a number.

Select Always use this phone number to always use your selected phone number for
Messaging toolbar feature operations. You may reset this option on the User Preferences
> General page, Play on Phone section.

4. Click Call.
The system calls the selected number and displays the Call Progress window.
5. Answer the phone and enter your password, when prompted.

6. Record your voice reply.

Voice Forward

Use Voice Forward to forward voice messages to callers in your organization’s voicemail system.
You can attach a voice introduction to the message being forwarded.

Forwarding a voice message
Procedure

1. Use your email client to open your voice message and then navigate to the Messaging
toolbar.

2. Click Voice Forward.

The system displays the Phone number selection window (unless you previously
selected Always use this phone number. See step 3).

3. Select the phone you want to use to forward a voice message.

+ Select Extension to use your extension.

+ Select Mobile to use your mobile phone. You can choose this option only if your
administrator has populated the mobile phone field.

» Select Other Mobile to use another mobile phone. You can choose this option if you
have entered a mobile number on the Other mobile phone or pager field on the User
Preferences > General page.

© Note:
Messaging supports only email based (SMTP) pager notifications.

» Select Other to manually enter a number.

Select Always use this phone number to always use your selected phone number for
Messaging toolbar feature operations. You may reset this option on the User Preferences
> General page, Play on Phone section.
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Operation

4. Click Call.
The system calls the selected number and displays the Call Progress window.
5. Answer the phone and enter your password, when prompted.

6. Follow the prompts to forward your message.

Call Sender

Use Call Sender to call the person who left the voice message in your message box.
Calling a voice message sender
Procedure

1. Use your email client to open a voice message, and then navigate to the Messaging
toolbar.

2. Click Call Sender.

The system displays the Phone number selection window, unless you previously
selected Always use this phone number. See Step 3.

3. Select the phone that you want to use to call the sender.
* Click Extension to use your extension.

* Click Mobile to use your mobile phone. You can choose this option only if your
administrator has populated the mobile phone field.

* Click Other Mobile to use another mobile phone. You can choose this option if you
entered a mobile number on the Other mobile phone or pager field on the User
Preferences > General page.

© Note:

Messaging supports only email-based (SMTP) pager notifications.
* Click Other to manually enter a number.

4. (Optional) Click Always use this phone number to always use your selected phone
number for Messaging toolbar feature operations. To reset this option, go to the Play on
Phone section on the User Preferences > General page.

5. Click Call.

The system calls the selected number and displays the Call Progress window, and plays
the Call Progress (ringback) audio simultaneously.

© Note:

You cannot return to the original call session or Messaging when the call sender
process is complete, regardless of whether the call sender process is successful or
fails.

6. Answer the phone and enter your password, when prompted.

The system calls the sender.
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Telephone user interface

Call progress

Messaging automatically reports the call progress when you use Play on Phone, Voice Reply,
Voice Forward, or Call Sender.

The Call progress window automatically closes after 10 seconds.

If the call fails, the system displays the reason for the call failure. The possible reasons for a call
failure are:

* The outgoing line is unavailable.
* The called number is busy or does not answer.
« Dial out privileges are not sufficient.

* The specified number is not a valid number.

Telephone user interface

A telephone user interface (TUI) makes human interaction with computers possible through a
voice or speech platform that starts an automated service or process. Messaging offers the
following TUIs that support many features and menus of the original TUIs:

* Aria TUI for Messaging: The Aria TUI supports many features and menus of traditional Octel
Aria systems.

* Audix TUI for Messaging: The Audix TUI supports many features and menus of traditional
Audix and Intuity Audix systems.

* CallPilot TUI for Messaging: The CallPilot TUI supports many features and menus of
traditional CallPilot and Meridian Mail systems.

© Note:

Your TUI preferences takes effect only after you log in to Messaging.

Voice messages

MWI and message status

Voice messages appear as unread until you access the messages over TUIs or mark the
messages as Read in your email client. The Message Waiting Indicator (MWI) of your desk phone
remains on until Messaging marks all voice messages in your Messaging Inbox as Read.

MWI functions in the Aria TUI
» The Aria TUI marks a message as Read only when you play the entire message.

* If you skip a message by pressing the pound key (#) within the default 10 seconds of
message playback, Messaging keeps the message as Unread and the MWI remains on.
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* If you skip a message by pressing the pound key (#) after the default 10 seconds of
message playback, Messaging marks the message as Read.

» From Messaging Release 6.1 Service Pack 1 onwards, if you save a message, Messaging
marks the message as Read even if you play the message for less than 10 seconds.

Administrators can configure the Messaging threshold after which Messaging marks a
message as Read even before you complete playing the entire message. Your Messaging
administrator must enable the Mark messages as Read feature for your mailbox so that you

can use the feature.
MWI functions in the Audix and CallPilot TUIs
» As soon as you start reviewing a message, Messaging marks the message as Read.

MWI functions in Outlook

If Outlook is in cached mode when you delete a message, the MWI light turns off only after the
next synchronization between Outlook and Exchange. The MWI light turns off when there is any
change in Outlook that influences the MWI:

* Read or unread status change
* Deletion of a message
* Moving a message to another folder

Moved messages

Voice messages can be moved from your inbox to other folders like any other email. Once a
message is moved, it is no longer available over the phone.

Message recovery

Messaging automatically saves your message if you lose your telephone connection while you are
recording a voice message. You can recover the unfinished message and resume your recording
session the next time you log in to your mailbox. This feature is only available to Aria TUI users.
You can apply all normal Aria TUI functions to the recovered message, including:

« Edit: You can rewind, fast-forward, pause, play, record, address, and send the message.

* Delete
 Skip: If you skip a recovered message, the Aria TUI reminds you about the message the next
time you log in to your mailbox.

 Exit: Skips any remaining recovered messages and returns you to the main menu.

Caveats and limitations

* You cannot recover partially recorded greetings, Caller Application announcements, spoken
names, or any other recordings.

» Messaging only saves an unfinished message when you lose connectivity to the telephony
server. Messaging does not save the message if the storage server goes offline or you
exceed the storage space in your mailbox during a recording session. If you disconnect the
call, the system saves the message.

* You cannot recover an unfinished message if the storage server is offline.
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* You cannot recover your message if you use an IMAP4 email client such as Outlook to move
the unfinished message out of the Drafts folder.

* You cannot recover unfinished messages using Messaging Web Access.

» Messaging does not save an unfinished messages when you record using a personal
computer in Messaging Web Access.

» Messages in the Drafts folder do not trigger a notification alert or cause the Message Waiting
Indicator to light up. Messaging does not warn you if you delete an unfinished message.

Message delivery
The Messaging TUIs provide following message delivery options:
* Important: You can mark your voice messages as Important.

* Private: You can protect your outgoing messages from being forwarded by the recipient by
marking the messages as Private.

When the Messaging storage destination is Avaya Message Store:

- Recipients of a Private voice message can play it either on a phone or on a personal
computer depending on the privacy configuration done by the administrator.

- Recipients cannot forward private voice messages.

When the Messaging storage destination is Exchange, Messaging only flags voice messages
as Private but otherwise not protected.

* Future delivery: You can set a future date on which you want the system to deliver your voice
message. In case you specify a delivery date without year and the specified date is less than
the current date, the system does not prompt any error but delivers the voice message on the
specified date next year.

Prevent message deletion

The Aria TUI prevents you from deleting voice messages that are being played.

The prevent message deletion feature is only available to Aria TUI users. Administrators can
configure the Messaging threshold after which you can delete a voice message during playback.

Your Messaging administrator must enable the prevent message deletion feature for your mailbox
so that you can use the feature.

Auto Delete Notification and Message Retention

Using the Auto Delete Notification feature, you can set the TUI to play a warning if any messages
are near the automatic deletion date. You can use your TUI to review the soon-to-be-deleted
messages and restore the messages that you want to keep.

The administrator configures the Messaging threshold for the message retention capacity. The
administrator must set appropriate permissions for you to use the Message Retention feature.
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© Note:

The TUI plays auto delete notification only when one or more messages are pending for
deletion.

Purging deleted messages

By default, Outlook does not automatically purge deleted messages. You might notice that when
you mark an item on an IMAP server for deletion, it is displayed in strike-through text. This can
lead users to unexpectedly run out of space in their mailboxes. The manual steps for purging differ
slightly depending on the Outlook versions.

Before you begin
Ensure that you are working online and connected to the IMAP server.
About this task

You can either manually purge messages marked for deletion, or configure Outlook to delete any
marked items when you switch between folders.

Procedure
1. For Outlook 2010 and 2013, perform the following steps to purge deleted items:
a. Open the folder from which you want to purge deleted items.
b. On the main menu, click Folder.
c. Click Purge and select Purge Marked Items in Folder name.

2. To configure Outlook 2010 or 2013 to delete any marked items when you switch between
folders, perform the following steps:

a. On the main menu, select Folder > Purge > Purge Options.

b. For Outlook 2010, click Deleted Items tab and select Purge items when switching
folders while online.

c. For Outlook 2013, click Advanced tab and select Purge items when switching
folders while online.

d. Click Ok.
3. For Outlook 2007, perform the following steps to purge deleted items:
a. Open the folder from which you want to purge deleted items.
b. On the main menu, click Edit.
c. Click Purge and select Purge Marked Items in Folder name.

4. To configure Outlook 2007 to delete any marked items when you switch between folders,
perform the following steps:

a. On the main menu, select Edit > Purge > Purge Options.
b. Click General tab and select Purge items when switching folders while online.
c. Click Ok.
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Non Delivery Report notification

You receive a Non Delivery Report (NDR) or Delivery Status Notification (DSN) when the system
exhausts all attempts to deliver a voice mail to the listed recipients. NDRs are not presented for
Exchange users. NDRs may not include the original message information and a recording of the
original message sent.

Messaging Web Access

Avaya Aura® Messaging Web Access is a secure web client for the Avaya message store users to
access and manage voice mail messages in their Messaging mailbox. Using Messaging Web
Access, the users can:

* Play voice messages on a telephone or personal computer.
* Record and send voice messages from a telephone or computer.

To play, record, and send voice messages through your computer, you need a headset or a
microphone and speakers.

* Forward voice messages.
* Reply to voice messages.
+ Call the sender of a voice message.
* Delete voice messages.
* Record, change, and manage your greetings.
» Change the status and subject of a voice message.
« Edit your mailbox account settings.
* Record and send login announcements.
Using Messaging Web Access, the users cannot:
» Capture and save a copy of a voice message to a file on your computer.

» Send or forward voice messages to local or remote subscribers outside the Messaging
system.

» Send or forward voice messages to email addresses.

© Note:

Messaging Web Access is not available to the users of Microsoft Exchange server.

When Avaya message store is offline, online users can do the following by using Messaging Web
Access:

« Compose new messages.

» Listen to voice messages in the cache.
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However, users cannot do the following:
* Delete voice messages.
* Reply, Reply all, and Forward a voice message.
* Mark voice messages as played or unplayed.
» Operate messages older than 72 hours.
» Gain access to the User Preferences page.
« Edit the subject of voice messages.
» Auto refresh or update messages on the Messages page.

Requirements
» An account or mailbox on Messaging 6.3 FP1 or later.
A personal computer with one of the following operating systems:

- Microsoft® Windows® 7 or later
- Apple Mac OS X 10.7 or later
A supported web browser. The following web browsers are supported:

Microsoft Internet Explorer 10 or later

Microsoft Edge
Mozilla Firefox 30 or later

Apple Safari 7 or later
- Google Chrome 35 or later
» Adobe Flash Player 14 or later for browsers that do not support HTML5.

© Important:

Adobe will end support of Flash Player on December 31, 2020.

* A headset or a microphone and speakers for playing and recording voice messages from
your computer.

HTML5 audio playback and recording support

As of release 7.1.0 Service Pack 3, Messaging supports HTML5 for audio playback and recording.
The following web browsers use HTMLS5 recording and playback capabilities by default:

* Microsoft Edge 76 or later
* Mozilla Firefox 30 or later
* Apple Safari 12.1 or later

» Google Chrome 35 or later

If you use any of these browsers, you do not need to use Adobe Flash Player. Other browsers,
such as Internet Explorer or Apple Safari 12 and below, do not support HTMLS5 recording and
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playback capabilities. These browsers will continue using the Flash audio player and audio

recorder.

Logging in to Messaging Web Access
About this task

Use this procedure to log in to Messaging Web Access to manage your voice messages. Ensure
that you do not log in to your Messaging account simultaneously with Messaging Web Access and
the telephone user interface (TUI).

You can log in to Messaging Web Access when the Messaging storage server is offline, but you
cannot send or receive messages.

Before you begin

* Ensure that the Messaging system administrator enabled the Messaging Web Access feature
for your mailbox.

* Ensure that your computer meets the Messaging Web Access requirements of the supported
operating systems and web browsers.

* Get the Messaging Web Access URL, your Messaging mailbox, and password from the
Messaging system administrator.

« Initialize your mailbox using a phone. For more information, see Using Avaya Aura®
Messaging on the Avaya Support site: http://support.avaya.com/.

Procedure
1. Go to the Messaging Web Access URL.

Example: https://<IP address or server name>:10100/

Where:

* <IP address or server name> Iis the logical IP address or the fully qualified
domain name (FQDN) of the server running Messaging Web Access.

* 10100 is the default destination port.

The system displays the Welcome dialog box.

2. If there are certificate errors, do the following:

a.
b.

April 2020

Go to the Messaging Web Access URL using Internet Explorer.

If the system displays the There is a problem with this website’s
security certificate message, click View Certificates.

If the system does not display any message, click the closed lock icon and then click
View certificates.

In the Certificate window, click Certification Path and select the certificate chain.

If the certificate chain contains an untrusted CA root certificate, add it to the Trusted
Root Certification store.
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For more information about this procedure, contact your system administrator.

o

Note:

If you are planning to use Messaging Web Access using Mozilla Firefox, you
might also need to import the CA root certificate into the Mozilla Firefox internal
certificates storage.

f. Ensure that the FQDN of the last certificate in the certification chain matches the
FQDN that is used for accessing the server.

3. In Mailbox, type your mailbox number.

4. In Password, type your password.

5. Select Remember me, if you want to log in to Messaging Web Access without entering
your mailbox number and password for the next 8 hours.

6. Click Log in.
The system displays the Avaya Aura® Messaging Web Access Messages page.

Welcome field description

Name Description

Mailbox The Messaging mailbox number that is your Messaging telephone
number.

Password The Messaging password.

Remember me

The feature by which the system remembers your Messaging Web
Access login credentials. The Messaging system administrator can
change the number of hours after which the Messaging Web Access
session expires. The default number of hours is 8 hours.

To use Remember me, the system administrator must enable the option
for your mailbox.

Avaya Aura® Messaging Web Access Messages view

Use the Messages page to view and manage your voice messages. For every voice message that
you receive, the system displays a notification at the bottom of the Messages page.

Microsoft® Windows® Internet Explorer 9 does not display the new message notifications if the
Messaging Web Access browser is inactive.

At the top of the Messages page, you can see one of the following connection statuses of
Messaging Web Access with the Messaging system notification server:

Icon Status Description
o) Connected Messaging Web Access is connected to the
Messaging system notification server and is
receiving updates from the Messaging system.
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Icon

Status

Description

Disconnected

Messaging Web Access is not connected to the
Messaging system notification server.

Messaging Web Access continues trying to connect
to the Messaging system notification server every
60 seconds until successful. If Messaging Web
Access cannot connect to the Messaging system
notification server for an extended time, contact
your system administrator.

You cannot receive or send messages in the
Disconnected state.

Trying to connect

Messaging Web Access is trying to connect to the
Messaging system notification server.

Limited availability

Messaging Web Access is connected to the
Messaging system notification server with limited
access.

Messages field description

Name Description

From The name of the sender of a voice message. Sorts the messages by
sender in ascending or descending order.

Subject The information about a voice message. For example, the name and
telephone number of the voice message sender. Sorts the messages by
subject in ascending or descending order.

Received The date and time of reception of a voice message. Sorts the messages
by date and time in ascending or descending order.

Duration The duration of a voice message including all attachments. Sorts the

messages by duration in ascending or descending order.

Icon description

Icon Name Description
Flag Displays the voice message tags, such as
Broadcast message or Login announcement (),
Private (&), or Important ( 4).
Sorts the messages based on tagged or untagged.
Select all Selects all the listed voice messages.
] Select Select a particular voice message from the list.

Button description

Button Description
Messages Displays the Messaging Web Access Messages page and a list of voice
messages.
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Button Description

Preferences Displays the Avaya Aura® Messaging User Preferences page to
customize the settings of your Messaging account.

Compose Records a new voice message to send to the appropriate people.

Login announcement Records and sends a message that appears in each mailbox. The
administrator must enable the Login announcement feature for your
mailbox.

Reply Records and sends a reply voice message to the sender of a voice
message.

Reply all Records and sends a reply voice message to all addressees of a voice
message.

Forward Forwards a voice message to other people. You can also record and send
a new message with a forwarded message.

Play message Plays a voice message. You can specify whether you want to play a
message using computer or telephone.

Call sender Calls the sender of a voice message.

Delete Deletes a voice message.

Playback devices

Messaging Web Access plays voice messages on a personal computer or a telephone. You can
select your playback device when you:

+ Compose a new message
* Play a message
* Forward a message
* Reply to a message
The playback options are:

* Play/record through desktop: Messaging Web Access plays all your voice messages on
your desktop. Play/record through desktop is the recommended option to gain access to all
Messaging Web Access functions and for better user experience.

* Play/record through telephone: Messaging Web Access plays all your voice messages on
your phone. Depending on the function you perform, the system displays the following dialog
boxes with the User Preferences configuration for your Messaging account:

- Play on Phone
- Voice Reply

- Voice Forward
- Voice Compose
- Call Sender

You must specify your telephone number in the dialog box.
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To prevent the display of the dialog boxes, select the Always use this phone number option on
the General tab in User Preferences.

When using the telephone as your default playback device, you must log in to your Messaging
mailbox using the telephone user interface (TUI).

Changing the default playback device
About this task

Use this procedure to change the default playback device using the following buttons on the
Messages page.

* Play message

* Reply

* Reply all

* Forward

» Compose
Procedure

1. On the Messages page, select a voice message and then click the appropriate button.
Alternatively, you can right-click the voice message and select the function from the menu.

Based on the button you select, the system displays a dialog box.
2. Click the Communication type icon at the top of the dialog box.
The system displays the following devices:
* Play/record through telephone
* Play/record through desktop
3. Select the appropriate playback device.

The system changes the Communication type icon based on your selection.

Messages

On the Messages page, after selecting a voice message, you can:

+ Listen to the voice message using a personal computer or a telephone.

Forward the voice message to other Messaging users.

Reply to the sender or all Messaging users to whom the selected voice message is
addressed.

Delete the voice message.

Call the sender of the voice message.
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Listening to a message
Listening to a message using a personal computer
About this task
Use this procedure to listen to a voice message that is sent by a Messaging user.
Procedure

On the Messages page, select the voice message that you want to play and click Play message.
Messaging plays the voice message on the computer.

Listening to a message using a telephone
Procedure

1. On the Messages page, select the voice message that you want to play and click Play
message.

2. In the Play on Phone dialog box, select the telephone number on which you want to play
the voice message and click Call.

Messaging calls your phone.
3. When your telephone rings, lift the receiver and log in to your Messaging mailbox.
Messaging plays the voice message.

4. After listening to the message, hang up the receiver, and close the Play on Phone and Play
message dialog boxes.

Preserving a message
About this task

Use this procedure to restart the retention timer and preserve a message before Messaging
automatically deletes the message.

Procedure

1. In the Play message dialog box, click [ More options.
The system displays the following options:
+ Call sender
* Preserve
2. Click Preserve.
The system retains the message by restarting the retention timer.

Play message field descriptions

Name Description
Received The date and time when you received the selected voice message.
From The name of the person who sent the selected voice message.
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notifications.

Name Description
To The name of the receiver of the selected voice message.
Subject The subject of the selected voice message. You can change the subject

of any message, except login announcement and delivery status

Button description

Button

Name

Description

s Message play slider

Plays the part of a message that you select using
the slider. You can move the slider right or left to
play an earlier or later part of a message.

> Play Plays a voice message.

0 | Pause Pauses the voice message that you are playing.
| Stop Stops playing the voice message.

) m—— Volume control slider Increases or decreases the volume of the playing

message.

Icon description

Icon Name Description

Number of recordings Displays the number of available recordings at the
top of the dialog box when a voice message has
multiple recordings. You can click the left arrow or
the right arrow to select the message that you want
to play.

@ | Delete Deletes a voice message.

Reply Records and sends a reply to the person who sent
you the selected voice message.

Reply all Records and sends a reply to all Messaging users
addressed on a voice message.

Forward Forwards the selected voice message to other
Messaging users. You can also record and send a
new message with the forwarded message.

B More options Displays the following options:
 Call sender: Calls the sender of the voice

message.

* Preserve: Restarts the retention timer and
preserves a message before Messaging
automatically deletes the message.
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Icon Name Description

ER Communication type Specifies the device to record and listen to the voice
message. The options are:

» Play/record through desktop
* Play/record through telephone

The system displays the icon corresponding to your
selection.

Replying to a message
Replying to a message using a personal computer
About this task
Use this procedure to record and send a reply by voice message.
Procedure
1. On the Messages page, select the voice message and click one of the following:
* Reply
* Reply all
2. |n the RE: dialog box, click @M Start recording and select one or more of the following:
* Re-record: To re-record the voice message.
» High importance: To set the priority status of the recorded voice message.
* Private: To set the privacy status of the recorded voice message.
» Attach original message: To attach the received voice message.
3. Click Send.

Replying to a message using a telephone
Procedure

1. On the Messages page, select the voice message and click Reply.
2. In the RE: dialog box, click Call.
3. In the Voice Reply dialog box, click Call.

Messaging calls your phone.

4. When your telephone rings, lift the receiver and log in to your mailbox. Use the appropriate
TUI commands to do the following:

» Record a voice message using the telephone user interface (TUI).
* Re-record the voice message.
+ Select the recipients for the voice message.

+ Set the priority status of the voice message.
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5. Send the message using the appropriate TUl command.

6. Hang up the receiver, and close the Voice Reply and RE: dialog boxes.

Reply field descriptions

Name Description

To The name or mailbox number of the person to whom you want to send
the voice message. By default, this field displays the name of the sender.
You can remove a person from the To list by clicking X next to the name.

Subject The subject of the voice message. You can change the subject of a voice

message.

High importance

The priority status of a voice message.

Private

The privacy status of a voice message.

Icon description

Icon

Name

Description

Ex

or

Communication type

Specifies the device to record and listen to the voice
message. The options are:

* Play/record through desktop
» Play/record through telephone

Messaging displays the icons corresponding to your
selection.

Add recipient

Adds recipients. The system displays the Choose a
Contact dialog box. You can select a contact from
the Enterprise contacts or Personal distribution list.

Start recording

Records a voice message through your personal
computer.

Messaging displays the dialog box and prompts you
to confirm that you are using a microphone. In the
dialog box, click Allow and start recording the
message. When you finish, click Stop or remain
quiet. The recording stops after 4 seconds of
silence, and the system plays your voice message.

[ =

Stop recording

Stops recording your voice message.

Button description

Button

Name

Description

s Message play slider

Plays the part of the message that you want to hear.
You can move the slider right or left to play an
earlier or a later part of a message.

Re-record

Re-records the voice message.
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Button Name Description

> Play Plays the voice message that you recorded.

[ ) Pause Pauses the voice message that you are playing.

" | Stop Stops playing the voice message.

[ s | Send Sends a recorded voice message to the specified
person.

Forwarding a message

Forwarding a message using a personal computer

About

this task

Use this procedure to forward a voice message. You cannot forward private messages.

Procedure

1.
2.

On the Messages page, select a message and then click Forward.

In the FW: dialog box, type the name or extension of the person to whom you want to
forward the message and click 23 Add recipient .

3. In the Choose a Contact dialog box, select the contact and then click OK.

5.

- Click &1 Start recording and select one or more of the following:

» High importance: To set the priority status of the voice message.
* Private: To set the privacy status of the voice message.
Click Send.

Forwarding a message using a telephone

About

this task

Use this procedure to forward a voice message. You cannot forward private messages.

Procedure

1.
2.
3.

April 2020

On the Messages page, select a message and then click Forward.
In the FW: dialog box, click Call.

In the Voice Forward dialog box, click Call.

Messaging calls your telephone.

When your telephone rings, lift the receiver and log in to your mailbox. Use the appropriate
TUI commands to do the following tasks:

» Record your voice message using the telephone user interface (TUI).
* Re-record your voice message.

+ Select the recipients of your voice message.
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+ Set the priority status of the voice message.

+ Set the voice message as private.

5. Send the message using the appropriate TUl command.

6. Hang up the receiver, and close the Voice Forward and FW: dialog boxes.

Forward page descriptions

Name Description

To The name or mailbox number of the person to whom you want to forward
the voice message.
You can remove a person from the To list by clicking X next to the name.

Subject The subject of the voice message. You can change the subject of a voice

message.

High importance The priority status of a voice message.

Private The privacy status of a voice message.

Icon description

Icon Name Description

EB Communication type Specifies the device to record and listen to the voice
message. The options are:

or
* Play/record through desktop

* Play/record through telephone
Messaging displays the icons corresponding to your
selection.

2] Add recipient Adds recipients. The system displays the Choose a
Contact dialog box. You can select a contact from
the Enterprise contacts or Personal distribution list.

e | Start recording Records a voice message through your personal
computer.

Messaging displays the dialog box and prompts you
to confirm that you are using a microphone. In the
dialog box, click Allow and start recording the
message. When you finish, click Stop or remain
quiet. The recording stops after 4 seconds of
silence, and the system plays your voice message.

(w | Stop recording Stops recording your voice message.

Button description
Button Name Description
/oeeeeeessems| Message play slider Plays the part of the message that you want to hear.
You can move the slider right or left to play an
earlier or a later part of a message.
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Button Name Description

= Re-record Re-records the voice message.

> | Play Plays the voice message that you recorded.

0 | Pause Pauses the voice message that you are playing.

u | Stop Stops playing the voice message.

=n Send Sends a recorded voice message to the specified
person.

Choose a Contact field descriptions

Name Description
Contact The name or telephone number of the contact that you want to find.
View The search locations. The options are:

» Enterprise contacts

* Personal distribution list

First name The first name of the contact that matches your search criteria.

Last name The last name of the contact that matches your search criteria.

Display name The display name of the contact that matches your search criteria.
Mailbox The mailbox number of the contact that matches your search criteria.
TO The name and the mailbox number of the selected contact. This contact

is the receiver of the voice message.

Icon description

Icon Name Description
B Search Searches the information specified in the Contact
box.

Composing a new message
Composing a message using a personal computer
About this task
Use this procedure to compose and send a voice message.
Procedure
1. On the Messages page, click Compose.

2. In the Compose New Message dialog box, type the name or extension of the person to
whom you want to send the message and click 23 Add recipient .

3. In the Choose a Contact dialog box, select the contact and click OK.
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Messaging Web Access

4. Click @ Start recording and select one or more of the following:
* Re-record: To re-record the voice message.
» High importance: To set the priority status of the recorded voice message.
* Private: To set the privacy status of the recorded voice message.

5. Click Send.

Composing a message using a telephone
Procedure

1. On the Messages page, click Compose.

2. In the Compose New Message dialog box, click Call.

3. In the Voice Compose dialog box, click Call.
Messaging calls your phone.

4. When your telephone rings, lift the receiver and log in to your mailbox. Use the appropriate
TUI commands to do the following:

* Record a voice message using the telephone user interface (TUI).
» Re-record the voice message.
+ Select the recipients for the voice message.
+ Set the priority status of the voice message.
» Set the voice message as private.
5. Send the message using the appropriate TUl command.

6. Hang up the receiver, and close the Voice Compose and Compose New Message dialog
boxes.

Compose New Message field descriptions

Name Description

To The name or mailbox number of the person to whom you want to send
the voice message.

You can remove a person from the To list by clicking X next to the name.

Subject The subject of the voice message. You can change the subject of a voice
message.
High importance The priority status of a voice message.
Private The privacy status of a voice message.
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Icon description

Icon

Name

Description

Ex

or

Communication type

Specifies the device to record and listen to the voice
message. The options are:

* Play/record through desktop
* Play/record through telephone

Messaging displays the icons corresponding to your
selection.

Add recipient

Adds recipients. The system displays the Choose a
Contact dialog box. You can select a contact from
the Enterprise contacts or Personal distribution list.

Start recording

Records a voice message through your personal
computer.

Messaging displays the dialog box and prompts you
to confirm that you are using a microphone. In the
dialog box, click Allow and start recording the
message. When you finish, click Stop or remain
quiet. The recording stops after 4 seconds of
silence, and the system plays your voice message.

-

Stop recording

Stops recording your voice message.

Button description

Button

Name

Description

s Message play slider

Plays the part of the message that you want to hear.
You can move the slider right or left to play an
earlier or a later part of a message.

=3 Re-record Re-records the voice message.

Ty Play Plays the voice message that you recorded.

0 | Pause Pauses the voice message that you are playing.
Cw | Stop Stops playing the voice message.

[ | Send Sends a recorded voice message to the specified

person.

Composing a login announcement

Composing a login announcement

About this task

Use this procedure to compose and send a login announcement.

Procedure

1. On the Messages page, click Login announcement.
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2
3.
4

5.

Messaging Web Access

Messaging displays the Compose Login Announcement dialog box.

- Click @& Start recording.

Click E£8 Stop recording.

. (Optional) Click gzzaRe-record.

Click Send.

Compose Login Announcement field descriptions

Icon

Name

Description

e

Start recording

Records a voice message
through your personal computer.

Messaging displays the dialog
box and prompts you to confirm
that you are using a microphone.
In the dialog box, click Allow and
start recording the message.
When you finish, click Stop or
remain quiet. The recording stops
after 4 seconds of silence, and
the system plays your voice
message.

d

Stop recording

Stops recording your voice
message.

Button description

Button

Name

Description

s Message play slider

Plays the part of the message that you want to hear.
You can move the slider right or left to play an
earlier or a later part of a message.

= Re-record Re-records the voice message.

> Play Plays the voice message that you recorded.

[ ) Pause Pauses the voice message that you are playing.
(w | Stop Stops playing the voice message.

[ s | Send Sends a recorded voice message to the specified

person.

Deleting a message
Procedure

On the Messages page, select the voice message that you want to delete and perform one of the
following:

* Click Delete.
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* Press the Delete key on the keyboard.

Messaging deletes the selected voice message from your mailbox.
Deleting multiple messages

Procedure

1. On the Messages page, press and hold the Control key on the keyboard and select the
voice messages that you want to delete.

2. Perform one of the following:
* Click Delete.
* Press the Delete key on the keyboard.

Messaging deletes the selected voice messages from your mailbox.

Changing the status of a message
About this task
Use this procedure to change the status of a voice message from:

» Unplayed to played without listening to the message. An unplayed message is displayed in
bold font.

* Played to unplayed to listen to the message again. The played message becomes bold again
to indicate an unplayed status.

Procedure
1. On the Messages page, right-click the voice message whose status you want to change.
2. In the pop-up menu, select one of the following:
* Mark as unplayed
» Mark as played
Messaging changes the status of the voice message.
Changing the subject of a message
Procedure
1. On the Messages page, right-click the voice message whose subject you want to change.
2. In the pop-up menu, click Edit subject.
Messaging displays the Change subject dialog box.

3. In the Change to field, specify the new subject.
4. Click Save.

Calling the sender of a message
Procedure

1. On the Messages page, select a voice message and then click Call sender.
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Fax

2. In the Call Sender dialog box, complete the phone details and click Call.
Messaging calls your phone.

3. When your telephone rings, lift the receiver and log in to your mailbox.
Messaging calls the sender of the voice message.

4. Hang up the receiver, and close the Call Sender dialog box.

Logging in to User Preferences from Messaging Web Access
About this task

Use this procedure to gain access to your Messaging mailbox preferences from Messaging Web
Access.

Procedure

In the Messaging Web Access window, click Preferences.
The system displays the User Preferences General webpage.
Next steps

Click the User Preferences menu tabs and customize your Messaging mailbox preferences.

Logging out of Messaging Web Access
About this task

Use this procedure to log out of Messaging Web Access to stop accessing your voice messages.

Procedure

At the top of the Avaya Aura® Messaging Web Access window, click Log out.

Fax

Using the fax feature of Messaging, you can perform the following:
» Receive faxes to a specified email address.
» Send faxes from any appropriately configured and supported version of Windows desktop.

Messaging administrators control which groups of users can send and receive faxes.
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Computer requirements
The Messaging fax client runs on any of the following operating system and Windows system
type:
» Operating system:
- Windows 7
- Windows 8
- Windows 8.1
- Windows 10
* Windows system type:
- 32 bit
- 64 bit

Inbound fax

The Messaging system receives inbound fax messages and forwards them to a specified email
address. The administrator must configure SMTP/mail gateway for Messaging to receive and
forward faxes to a specified email address. You can receive fax messages to any the following
email addresses depending on your Messaging mailbox configuration:

* The email address specified in the internal corporate directory.
* The email address specified in the User Preferences webpage.

The maximum transmission length of an inbound fax is 90 minutes. After 90 minutes, Messaging
stops the transmission and sends a report to the sending fax server. The report includes the
number of pages transmitted successfully.

You cannot gain access to inbound faxes from the TUIs because Messaging does not store any
faxes in the message store. Message Waiting Indicator of the TUIs does not light up on receipt of
a new fax.

Cache for fax

The Messaging system only caches inbound faxes if you have a specified email address in User
Preferences. The system does not cache outbound faxes or inbound faxes sent to a fax server.

The default retention period for a cached fax is 72 hours. Messaging administrators can modify the
retention period.

Outbound fax

Using Messaging, you can compose a document in a Windows-based program and fax it to any
destination fax number. The Messaging fax client on your desktop sends your document to the fax
printer service on the Avaya storage server. The fax printer service sends the document to the
application role, which sends it to the destination fax number.
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You can change fax-related defaults in User Preferences.
Outbound fax has the following features:

* You can customize Transmitting Subscriber Identification (TSID) for outbound fax jobs. The
TSID is a string that identifies a specific fax machine as the sender of a fax transmission. By
default, the Messaging system assigns each user a TSID in the format mailbox@external
access number. You can change the default value of TSID through the General section of the
User Preferences webpage.

* You can configure email notifications for outbound fax. You can configure Messaging to send
a status notification by email for each fax that you send. You can enable the notification
through the Notify Me section of the User Preferences webpage.

* You can monitor the status of your outbound fax jobs. An outbound fax job is similar to a print
job. You can view and cancel your outbound fax jobs using the remote fax printer configured
on your Windows desktop. You can also delete failed fax jobs and remove them from the
queue.

Outbound fax has the following requirements:

» Messaging requirements. Your Messaging administrator must enable the fax support and
dialing privileges for your mailbox so that you can use the fax features.

» Computer requirements. Your computer must support the Internet Printing Protocol (IPP)
feature and HTTP printing.

Messaging fax client pre-installation checklist

Get the administrator permission for the following Messaging fax client pre-installation tasks:

No. Task Description Notes v
1 Configure the Internet » See Turning on the IPP By default, your

Printing Protocol (IPP) feature on Windows 7 on computer has this

feature page 54 printing capability.

However, some
companies disable this
capability for security

reasons.

2 Configure the HyperText » See Turning on the HTTP By default, your
Transfer Protocol (HTTP) printing on Windows 7 on computer has this
printing page 54 printing capability.

However, some
companies disable this
capability for security
reasons.

3 Download a fax client « See Downloading a fax client
installer installer on page 54

» See Supported languages for
the fax client installer on
page 55
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IPP feature configuration

Turn on the IPP feature of your computer to enable secure remote printing. After enabling the IPP
feature, you can send messages to the Messaging fax client to print and generate fax messages.

Turning on the IPP feature on Windows 7
Before you begin

Get the administrator permission for enabling the IPP feature on computers running on Windows
7.

Procedure
1. Click Start > Control Panel > Get programs > Turn Windows features on or off.
Windows displays the Windows Features window.
2. Expand Print and Document Services.
3. Select Internet Printing Client.
4. Click Ok.
HTTP printing configuration

Turn on the HTTP printing of your computer to send fax messages from your computer to the
network fax printer service on the Messaging storage server.

Turning on the HTTP printing on Windows 7
Before you begin
Get the administrator permission to enable the HTTP printing on your computer.
Procedure
1. Click Start > Run.
2. In the Open field, type regedit, and click OK.
3. Click HKEY_LOCAL_MACHINE > SOFTWARE > Policies > Microsoft.
4. Click Windows NT > Printers.
5. Double-click DisableHTTPPrinting, and set the value to 0.
6. Click OK.
Downloading a fax client installer
About this task

Download the fax client installer from the Messaging storage server on your computer for a
specific language that you have set in the User Preferences webpage.

© Important:

You must save the fax client installer on a local drive of your computer. You cannot install a fax
client from a shared location or a network drive.
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Before you begin
Get the administrator permission for downloading the fax client installer.
Procedure

1. In Internet Explorer, type http://<Messaging storage server IP or AAM
FODN>/download/<fax client installer>

where

» <Messaging storage server IP or AAM FQDN> is the fully qualified domain name or IP
address of the Messaging server functioning as a storage server.

 <fax client installer> is the .msi file for a specific language that is required to install the
fax client for that language.

2. Press Enter.
3. (Optional) Click Continue to this website (not recommended).

The system displays a dialog box with the message: Do you want to run or save <fax
client installer> from <Messaging storage server IP or AAM FQDN>?

4. Click Save.
The system saves the fax client installer on your computer.

Supported languages for the fax client installer

Language Fax client installer file name
Arabic FaxClient-ar-SA.msi
Chinese-Peoples Republic of China FaxClient-zh-CN.msi
Chinese-Hong Kong FaxClient-zh-HK.msi
Dutch FaxClient-nl-NL.msi
English-US FaxClient-en-US.msi
French FaxClient-fr-FR.msi
French-Canadian FaxClient-fr-CA.msi
German FaxClient-de-DE.msi
Hebrew FaxClient-he-IL.msi
Italian FaxClient-it-IT.msi
Japanese FaxClient-ja-JP.msi
Korean FaxClient-ko-KR.msi
Polish FaxClient-pl-PL.msi
Portuguese-Brazilian FaxClient-pt-BR.msi
Portuguese-European FaxClient-pt-PT.msi
Russian FaxClient-ru-RU.msi
Spanish-Latin American FaxClient-es-XL.msi
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Language Fax client installer file name
Spanish-Castilian FaxClient-es-ES.msi

Swedish FaxClient-sv-SE.msi

Turkish FaxClient-tr-TR.msi

Installing Messaging fax client
About this task

The Messaging fax client is a printer driver that prints your messages and generates fax
messages. Note that, the Messaging fax client fails to install if the CallPilot desktop Messaging
client is already installed.

Before you begin
» Complete the fax client pre-installation procedures.
» Uninstall the CallPilot desktop Messaging client.
Procedure
1. Run the fax client installer for your language.
2. Select | accept the terms in the License Agreement.
3. Click Install, and follow the instructions in the installation wizard.
4

. Click Finish.

Messaging installs the fax client and adds Avaya Aura® Messaging Fax printer driver to the
list of Printers and Faxes.

5. Restart the computer.
Next steps

Configure the fax printer service to Windows.

Fax printer service configuration

The fax printer service is the remote fax printer on the Messaging storage server, where you send
fax messages. Add the fax printer service as a network printer on the Windows desktop to send
faxes to a destination number based on your dial-out privilege.

Adding the fax printer service as a network printer on Windows 7

Before you begin
Install the Messaging fax client on your computer.

Procedure
1. Click Start > Devices and Printers > Add a printer.
Windows displays the Add Printer window.

2. Click Add a network, wireless or Bluetooth printer > The printer that | want isn’t
listed.

April 2020 Using Avaya Aura® Messaging 56

Comments on this document? infodev@avaya.com



mailto:infodev@avaya.com?subject=Using Avaya Aura®‎‎ Messaging

Fax

3. Select Select a shared printer by name.

© © N o

In the search text box, type http://<Messaging storage server IP or AAM
FODN>:8631/printers/fax.

where <Messaging storage server IP or AAM FQDN> is the fully qualified domain name or
IP address of the Messaging server functioning as a storage server.

Click Next.

Windows displays the Configure Internet Port window.

In the User Name field, type your mailbox number.

In the Password field, type your mailbox password.

Click OK, and follow the instructions of the Add Printer wizard.

Click Finish.

The system adds the following remote network printer to the Windows environment:
+ fax on http://<Messaging storage server IP or AAM FQDN>:8631

where <Messaging storage server IP or AAM FQDN> is the fully qualified domain name or
IP address of the Messaging server functioning as a storage server.

Adding the fax printer service as a network printer on Windows 8 or later
About this task

If you are using a touch screen computer, tap to perform the steps.

Before you begin

Install the Messaging fax client on your computer.

Procedure

1.
2.

Navigate to Control Panel.
Click Devices and Printers > Add Printer.

Windows displays the Add Printer window.

. Click Add a network, wireless or Bluetooth printer > The printer that | want isn’t

listed.

. Select Select a shared printer by name.

5. In the search text box, type http://<Messaging storage server IP or AAM

April 2020

FODN>:8631/printers/fax.

where <Messaging storage server IP or AAM FQDN> is the fully qualified domain name or
IP address of the Messaging server functioning as a storage server.

. Click Next.

Windows displays the Configure Internet Port window.

In the User Name field, type your mailbox number.
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8. In the Password field, type your mailbox password.
9. Click OK, and follow the instructions of the Add Printer wizard.
10. Click Finish.
The system adds the following remote network printer to the Windows environment:
+ fax on http://<Messaging storage server IP or AAM FQDN>:8631
where <Messaging storage server IP or AAM FQDN> is the fully qualified domain name or
IP address of the Messaging server functioning as a storage server.
Sending a fax

About this task

Using Messaging, you can send faxes to local, national, or international numbers depending on
your dial-out privileges. You can use any Windows-based program, such as Microsoft Word, to
draft your fax content. The fax client sends the drafted content without any cover page.

° Note:

Messaging does not support sending faxes to extensions registered to the sender’s mailbox.
Before you begin
* Install the outbound fax client on your computer.
* Add the remote network printer to your environment.

* Request your administrator to configure the dial-out privileges for you to send a fax to a
destination number.

* When sending fax to a Messaging mailbox, ensure that the Messaging mailbox of the fax
receiver has fax privileges.

Procedure
1. Create a document in Windows with the content that you want to send as a fax message.
2. Click File > Print.
3. From the list of printers, select Avaya Aura® Messaging Fax.
4. Click Print.
The system displays Avaya Aura® Messaging Fax Client.

5. In the Printer URL field, select http://<server name or IP>:8631/
printers/fax

where

* http://<server name or IP>:8631/printers/fax is the remote fax printer that
you set up earlier. The system uses this printer to send the fax.

» <Messaging storage server IP or AAM FQDN> is the fully qualified domain name or IP
address of the Messaging server functioning as a storage server.

6. In the Destination Fax field, type the fax number of the recipient.
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If you are unsure of the format that you must use for an external fax number, contact your
administrator.

7. To preview your fax, select Display fax content.
8. Click OK.
If you enabled outbound fax notifications, the system sends you an email notification with
the status of each outbound fax job.
Managing outbound fax jobs

About this task

You can manage an outbound fax job as you manage the regular print jobs. You can cancel an in-
progress fax job or delete a failed fax job.

Procedure
1. Click Start > Devices and Printers.
2. Double-click fax on http://<Messaging storage server IP or AAM FQDN>:8631

where <Messaging storage server IP or AAM FQDN> is the fully qualified domain name or
IP address of the Messaging server functioning as a storage server.

3. Perform one of the following:
» To cancel a fax job that is in-progress, right-click the fax job and click Cancel.

* To delete a failed fax job, right-click the fax job and click Delete.

Changing your password in the network fax printer service

About this task

If you change your Messaging password, you must update the password in the network fax printer
service on the Messaging server. Otherwise, you cannot send faxes.

Procedure
1. Click Start > Devices and Printers .
2. Click fax on http://[<Messaging storage server IP or AAM FQDN>:8631

where <Messaging storage server IP or AAM FQDN> is the fully qualified domain name or
IP address of the Messaging server functioning as a storage server.

3. Click Print server properties > Ports.

4. Selectthe port http://<Messaging storage server IP or AAM FQDN>:8631/
printers/fax

where <Messaging storage server IP or AAM FQDN> is the fully qualified domain name or
IP address of the Messaging server functioning as a storage server.

5. Click Configure Port.

Windows displays the Configure Internet Port window.
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6. In the Password field, type your new mailbox password.
7. Click OK twice.

Teletypewriter

A teletypewriter (TTY) is a data terminal that people who are hearing impaired or speech impaired
can use to transmit and receive text through a telephone system. A TTY is also referred to as
Telecommunications Device for the Deaf, or TDD. A typical TTY resembles the keyboard of a
laptop computer with a one-line or a two-line alphanumeric display. The TTY is silent when it is not
used to transmit text. As a user types on the device, the TTY emits audio tones that the telephone
network transmits.

Not all TTY users transmit and receive messages with TTY devices. Approximately half of the
people who rely on TTY devices are hearing impaired, but can speak clearly. They often prefer to
receive messages on their TTY devices and then speak in response. This process is referred to as
Voice Carry Over, or VCO.

Messaging only supports the Audix TUI with the TTY devices. Also, Messaging does not provide
automatic TTY support in Messaging mailboxes. Administrators need to enable TTY support. In
Messaging, administrators can configure mailboxes so that callers can select TTY-format, or voice
prompting from the same mailbox.

Messaging teletypewriter user interface

In Messaging, the administrator installs the US English TTY language pack to provide the TTY
support. The TTY prompts make most Messaging features available to users of TTY devices.
Messaging users can send, receive, and respond to TTY messages with a TTY device. Users
press the same telephone keys to send, receive, and respond to TTY messages and voice
messages.

Users whose mailboxes are set up for TTY can:
» Use the TTY language for most Messaging menus, prompts, and messages.
» Use Messaging to answer incoming telephone calls with a TTY greeting.
Callers can use the Messaging TTY or voice prompts when they record messages.

Messaging also supports the use of TTY and voice during the same call. For example, during a
VCO session, a user can receive a prompt in TTY format and then record a voice message.
Hearing impaired people who speak clearly can receive messages with a TTY device and send a
voice message during the same call.
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Important information for TTY users

Recommended hardware

Ensure that you use push-button or touchtone dialing during your call to make menu selections or
enter data. Many TTY devices, including the Avaya Model 8840 TTY, can generate touchtones to
dial a number. However, after the call is connected, these devices switch automatically from
touchtone mode to TTY mode. For this reason, you need to use a separate touchtone telephone
with the TTY device. One way to do this is to use an acoustic coupler to connect the TTY device
and the telephone.

An alternative approach is to use the TTY with an Avaya IP Softphone. Configure the IP
Softphone to be in Telecommuter mode and designate the TTY device as the associated analog
telephone. The IP Softphone user interface allows touchtones to be transmitted to Messaging.

For more information on configuring the IP Softphone to be in Telecommuter mode, refer to the
guide Using Avaya one-X® Communicator, topic name: Configuring outgoing call settings.

Messaging prompts

When you use Messaging with a TTY device, the system displays menus and prompts on the TTY
device. The menus and prompts present options for Messaging features. Frequently, you get
Messaging prompts to press numbers or type letters and characters on the telephone keypad.
When you press the keys on the telephone keypad in response to the prompts, you send
commands in the form of touchtone signals to Messaging. The only time that you type on the TTY
device is after you receive the Go Ahead (GA) prompt.

Teletypewriter tones to text conversion

When you receive a voice message, the TTY device either displays no text, or occasional random
characters. When a message contains voice, the signal indicator on the TTY device fluctuates
randomly. The TTY device converts the TTY tones to text on the TTY device display, but cannot
similarly convert audio voice messages to text. If necessary, request assistance from another
person, such as a relay operator.

Messaging and Teletypewriter signaling

Two Messaging TUI options interfere with the signaling between Messaging and TTY devices.
TTY device users cannot use TUI features that:

» Adjust the playback speed of a voice message.
+ Skip forward or backward within a message while the message is playing.

For example, if you change the playback rate of a Messaging TTY message, you also change the
baud rate of the transmission. Messaging and the receiving TTY device are no longer
synchronized.

© Note:

These TUI features might not be available for your TUI.
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For more information about TTY related troubleshooting, see Typographical errors and missing
characters in messages on page 105.

Messaging mailbox access using a TTY device

When you access your Messaging mailbox using a TTY device, Messaging sends instructions in
the TTY language format. You can log in to Messaging using one of the following:

* ATTY device.

* A telephone phone connected to a TTY device.

Logging in using a TTY device
About this task
You can perform this task only when your organization uses TTY as the default language.
Procedure
1. Dial your office telephone number from your office extension.
2. At the prompt, enter your password in TTY, and press the pound key (#).
Result

The TTY device displays your name and informs you if have any new messages. The TTY device
also displays a list of menu options.

Logging in dialing the Messaging access number
About this task

You can perform Step 3 and Step 4 only when your organization uses TTY as the default
language.

If your organization has a separate number that sends prompts in TTY only, use that number to
access Messaging.

Before you begin
» Get your Messaging access number.

If your organization allows Automated Attendant to access the Messaging system, you can
also use the Automated Attendant number to access Messaging. In that case, after logging in
to Messaging, you must select TTY as your default language.

» Set TTY as the user language on the User Preferences General webpage.
Procedure
1. Dial your Messaging access number from your office extension.

2. At the prompt, enter your password, and press the pound key (#).
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3. (Optional) If you are dialing from another telephone extension or outside your organization
without an associated Messaging mailbox:

a. Press the pound key (#).
b. Enter the Messaging mailbox number of your extension and then press the pound key
(#)-
c. At the prompt, enter your password, and press the pound key (#).
4. (Optional) If the other telephone extension has an associated Messaging mailbox:
a. Press star (*) to return to the main menu.
b. Repeat Step 3a to Step 3c.
Result

The TTY device displays your name and informs you if have any new messages. The TTY device
also displays a list of menu options.

Using the Messaging teletypewriter user interface

Recording your name
About this task

The Messaging system stores your name in your mailbox. To change your name, follow the TTY
prompts for your TUI. When Messaging prompts you to record your name, use your TTY device to
type your name. Ensure that you wait for the GA prompt before you start to type.

© Note:

To ensure that the text you type displays correctly when played back, do the following on your
TTY device before you type your name:

Procedure
1. Log in to Messaging using your TTY device.
2. Press 5 twice to navigate to the Record Name menu.
3. Type a single digit or a forward slash (/).

4. Press Spacebar on your TTY device a few times.

Recording and sending messages
About this task
The TUI that you use determines how you record and send messages.
Procedure
1. Log in to Messaging using your TTY device.

2. Press the appropriate telephone key to record a message.
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Operation

3. When the TTY device displays the GA prompt, type your message, and then press the
pound key (#).

4. Dial the mailbox number of the person to whom you want to send the message.
5. Press the pound key (#).
The TTY device displays the name of the person.

* If the TTY device display is blank, the name was not recorded for Messaging using a
TTY device. If the mailbox number is correct, continue with Step 6.

* If the TTY device displays an incorrect name, you might have dialed the wrong mailbox
number. Press the appropriate telephone key to delete the address, and repeat Step 4.

6. Press the pound key (#) to end the addressing.

7. Press the appropriate telephone key combination for your TUI to send the message.
Depending on your TUI, you can send a message in the following ways:

* Immediately or later.
» As a private or a normal message.
» As a high-priority or a standard priority message.

8. The system transmits your message and returns you to the main menu.

Getting and responding to messages
About this task
The TUI you use determines how you get messages.
Procedure
1. Log in to Messaging.

2. Press the appropriate telephone key to get and respond to the messages that people sent
you.

3. Messaging proceeds with the first new message and provides prompts for actions that you
can perform. Depending on your TUI, you can send or forward messages by using the
following methods:

+ Call the sender.

* Reply to the message.

» Forward the message with a comment.

* Reply to all recipients.

» Send a message now or later.

» Send the message as a private message.
» Send the message as a priority message.

» Delete the message.
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» Save the message.
+ Skip to the next message.

The TTY device displays the next message in your mailbox.
4. Repeat step 3 for each new message in your mailbox.

When there are no new or saved messages in your mailbox, Messaging returns you to the
main menu.

Administer greetings

When you do not answer a call, the call is transferred to voicemail and Messaging plays the
greeting that you recorded.

Ensure that your personal greeting contains both voice and TTY portions.

 Voice portion: You can record a brief voice message to tell callers that they reached a TTY
mailbox. Tell callers that they can press 1 to leave a voice message.

» TTY portion: While recording the voice portion, add a TTY recording to the greeting. In the
greeting, tell TTY callers to leave a TTY message after they receive the GA prompt.

You do not need to record a personalized greeting. If you choose not to record a personalized
greeting, the system plays a predefined greeting.

If your active Call Answer language is TTY, Messaging displays the TTY prompt “Leave a
message for <number>.”

If the caller selects a spoken language, Messaging plays the spoken prompt “Please leave a voice
message for <name>.”

The TUI you use determines how you administer greetings.

Recording a combined spoken and TTY greeting
About this task
To record a combined spoken and TTY greeting for your primary greeting:
Procedure
1. Log in to Messaging.

2. Press the appropriate telephone key to select the Personal Configuration or greetings
menu.

3. Press the appropriate telephone key to record the personal greeting.

4. When Messaging displays the GA prompt on the TTY device, use the telephone handset to
record the brief spoken portion of your greeting.

© Important:

Keep the spoken portion of your greeting brief, so that TTY callers do not think that
they have reached the wrong number.

The following message is an example of what you can record:
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“This is the TTY mailbox for John Smith. To leave a voice message, press 1 now”
5. Press the appropriate telephone key to stop recording the voice portion of the greeting.

6. Hang up the handset. If you use a TTY device with an acoustic coupler, place the handset
into the coupler

7. Press the appropriate telephone key to resume recording
8. When you see the GA prompt, type your TTY greeting.
The following message is an example of what you can type:

“John Smith is not available. Please leave a message after you receive the GA prompt.
When you finish, you can hang up or press 1 for more options”

9. Press the appropriate telephone key immediately to stop recording.

10. Press the appropriate telephone keys to accept, delete, or record the greeting again.

Place a call to another TTY user

A caller can use a telephone or a TTY device to place a telephone call to a user who uses a TTY
device.
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Chapter 5: Customizing Messaging

Use the User Preferences webpages to configure options for various Messaging features and
customize your Messaging mailbox.

Some user preferences are optional. For more information, contact your Messaging administrator.

Logging in to User Preferences
About this task
Use this procedure to gain access to Messaging User Preferences.
Procedure
1. Perform one of the following:

» Open a web browser, in the address bar type the URL for User Preferences that your
system administrator provided and press enter.

* Click User Preferences on the Messaging toolbar in Outlook.
The system displays the Messaging User Preferences login page.
2. In the Mailbox number field, type your mailbox number.
3. In the Messaging password field, type your password.
4. Click Log In.
The system displays the User Preferences General webpage.
Next steps

Click the User Preferences menu tabs and customize your Messaging mailbox preferences.

Logging in to User Preferences from Messaging Web Access
About this task

Use this procedure to gain access to your Messaging mailbox preferences from Messaging Web
Access.
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Customizing Messaging

Procedure
In the Messaging Web Access window, click Preferences.
The system displays the User Preferences General webpage.

Next steps
Click the User Preferences menu tabs and customize your Messaging mailbox preferences.

General

The following preferences are available on the User Preferences General webpage:

* Messaging Access Number

Account Information

Location and Language

Mobile Phone or Pager

Message Blocking Options
* Fax

* Play on Phone

Attendant

Some general preferences are optional. For more information, contact your Messaging
administrator.

Enabling auto login

Before you begin

Ensure that you have permission to use the auto login feature. For more information, contact your
administrator.

About this task

Use this process to enable automatic login for your mailbox using the assigned phone extensions
without having to enter your Messaging mailbox and password.

Procedure
1. Navigate to the User Preferences General webpage.

2. In the Account Information section, select the Enabled Auto Login for the following
allowed numbers check box.

3. Select the Auto login check box for the extensions that you want to use for automatic
login to your Messaging mailbox.
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Configuring location and language
About this task
Use this procedure to select your preferred time zone and language.
Procedure
1. Navigate to the Location an Language section in the User Preferences General webpage.
2. From the Time zone drop-down list, select your preferred time zone.

3. From the Language drop-down list, select your preferred language that you want to use in
the voice messaging system.

Specifying mobile phone or pager number
About this task
Use this procedure to specify the alternate mobile phone or pager number for integrated login.
Procedure
1. Navigate to the Mobile Phone or Pager section in the User Preferences General webpage.

2. Select the Use this mobile phone or pager for "Notify Me" and other features check
box, and specify an alternate mobile phone or pager number.

Blocking callers
About this task

Use this procedure to allow or prevent callers from leaving voice messages in your mailbox.
Procedure

1. Navigate to the Message Blocking Options section in the User Preferences General
webpages.

2. From the Block callers from leaving messages drop-down list, select any of the
following options:

* Never
* Always
» Only when extended absence greeting is active

3. (Optional) In the Blocked callers will be played the greeting, then field, select any of
the following options:

* Disconnected
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» Transferred to a custom attendant (operator)

Messaging enables the Blocked callers will be played the greeting, then field only when
you select Always or Only when extended absence greeting is active options from the
Block callers from leaving messages drop-down list.

Configuring TSID for outbound fax

Before you begin

Consult your administrator before changing the transmitting subscriber identification (TSID)
assigned to outbound faxes, using which fax recipients identify the origin of an incoming fax.

Procedure
1. In the User Preferences General webpage, navigate to the Fax section.

2. In Transmitting subscriber ID for outgoing fax messages, type a TSID with maximum
128 characters.

The default value of TSID for outgoing fax messages is <Extension>@<External
Messaging Access Number>.

3. Click Save.

Defining an email address for inbound fax

About this task

Messaging directs your inbound fax messages to the email address specified in the internal
corporate directory of your organization. However, you can direct inbound fax messages to a
different email address by specifying the new address on the User Preferences General webpage.

Procedure
1. In the User Preferences General webpage, navigate to the Fax section.
2. Select Forward incoming fax messages to and type the email address.
3. Click Save.

Enabling play on phone

About this task

Use this procedure to specify the phone number for Messaging to use for Play on Phone, Voice
Reply, Voice Forward, or Call Sender in the Messaging toolbar of an email client.

Procedure

1. Navigate to the Play on Phone section of the User Preferences General webpage.
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General

2. In the When playing a voice message in Outlook using “Play on Phone” field, select
any of the following options:

» Always use this phone number and select a phone number from the drop-down list.

* Ask me every time which phone to use

Enabling call forward
About this task

Use this procedure to enable call forward, where Messaging forwards a call when the caller
presses 0 while listening to your voice message greeting.

Procedure
1. Navigate to the Attendant section of the User Preferences General webpage.

2. In the When callers press “0” during my greeting, forward to field, select any of the
following options:

» Default attendant (operator)

» Personal attendant/assistant and specify a phone number.

General field descriptions

Messaging Access Number

Name Description

Internal The number to access your Messaging mailbox from inside the office.
Incase of multiple internal or external Messaging access numbers, use
the number that is assigned to a language that you know.

External The number to access your Messaging mailbox from outside the office.
You can call the external Messaging access number from your mobile
phone. If Messaging recognizes the mobile phone number, Messaging
prompts you to enter your mailbox password, skipping the need for you to
enter your mailbox number.

For Messaging to recognize your mobile phone number, enter your
mobile phone number in the correct format in the Mobile Phone or Pager
section on the User Preferences General webpage.

Find out the mobile phone number format that Messaging accepts by
calling your desk phone from your mobile. The caller ID of the desk
phone displays the correct mobile phone number format that Messaging
accepts.

Incase of multiple internal or external Messaging access numbers, use the number that is
assigned to a language that you know.
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Account Information

Name

Description

Mailbox

The assigned voice Messaging mailbox number.

Enabled Auto Login for the
following allowed numbers

The option to enable automatic login for your mailbox using the assigned
phone extensions without having to enter your Messaging mailbox and
password. Your administrator must enable the auto login feature for your
mailbox.

Extension

The assigned phone extensions.

Auto login

The option to log in to your mailbox using the extension. Your
administrator must enable the auto login feature for your mailbox.

Additional Extensions

The additional phone extensions associated with your mailbox.
Messaging displays the field only when your mailbox has additional
extensions.

Location and Language

Name

Description

Time zone

The preferred time zone. Selecting a time zone affects the date and time

announcement that the phone plays when you listen to a voice message

using the telephone user interface. Changes to the time zone also impact
the Reach Me Schedule on the Reach Me menu.

Language

The preferred language that you want to use in the voice messaging
system. If this field is unavailable, the default language is available. This
setting affects the following:

* The language of the voice prompts you hear when accessing your
Messaging mailbox through the telephone user interface.

» The language used for your User Preferences webpages.

You can configure a specific call answer language as the default call
answer language with two additional call answer languages. You must
have appropriate permissions to define multiple call answer languages.

0 Important:

You must not configure multiple languages when using One-Step
Audix Recording feature, but configure a single default call answer
language.
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Mobile Phone or Pager

General

Name

Description

Use this mobile phone or
pager for "Notify Me" and
other features

The alternate mobile phone or pager number for integrated login.
Messaging uses the specified number to:

 Notify Me for phone notifications.

Your administrator must enable the Notify Me feature for your mailbox.
» Reach Me for forwarding calls.

Your administrator must enable the Reach Me feature for your mailbox.

+ Other mobile phone for Play on Phone, Voice Reply, Voice Forward,
and Call Sender in your email client.

Messaging supports only email based (SMTP) pager notifications.

Message Blocking Options

Name

Description

Block callers from leaving
messages

The option to allow or prevent callers from leaving voice messages in
your mailbox. The available options are:

* Never: Callers can record voice messages. This option is the default
setting.

» Always: Callers cannot record voice messages.

» Only when extended absence greeting is active: Callers cannot
record voice messages if you recorded and enabled an extended
absence greeting.
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Name

Description

Blocked callers will be
played the greeting, then

The option to process an incoming call. The following table explains how
Messaging processes an incoming call: by disconnecting or by

transferring the call to a custom attendant.

Options Never | Always Only when extended
absence greeting is
active

Disconnected NA Messaging Messaging

disconnects the
call after playing
the message that

disconnects the call
after playing the
extended absence

the mailbox
owner does not
accept voice

greeting.

messages.
Transferred to a | NA Messaging Messaging transfers
custom transfers the call | the call to a custom
attendant to a custom attendant after playing
(operator) attendant. the extended absence

greeting.

The administrator must enable permission to use the incoming message
blocking options.

Fax

Name

Description

Forward incoming fax
messages to

The alternate email address where Messaging directs inbound fax
messages.

Transmitting subscriber ID
for outgoing fax messages

The string using which fax recipients identify the origin of an incoming fax.
A TSID has maximum 128 characters. The default value of TSID for
outgoing fax messages is <Extension>@<External Messaging
Access Number>.

Consult your administrator before changing the transmitting subscriber
identification (TSID) assigned to outbound faxes.

Play on Phone

Messaging displays a pop-up window to specify the phone number that Messaging must use when
clicking Play on Phone, Voice Reply, Voice Forward, or Call Sender on the Messaging toolbar of
an email client. The options to manage the pop-up are:

Name

Description

Always use this phone

The phone number that you want to use for Play on Phone, Voice Reply,

number Voice Forward, or Call Sender. Messaging uses the phone number
without any prompt and pop-up for this purpose.
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Notify Me

Name Description

Ask me every time which The option to restore the default setting where Messaging displays a pop-

phone to use up that prompts you to select a phone each time you use Play on Phone,
Voice Reply, Voice Forward, or Call Sender.

Attendant

The options to specify where Messaging must forward a call when the caller presses 0 while
listening to your voice message greeting, are:

Name Description

Default attendant (operator) | The system attendant or the operator.

Personal attendant/ The alternate phone number. The alternate phone numbers are:
assistant

* Internal: A phone extension.

» External

Messaging accepts any phone number formatting.

The administrator must enable the feature for your mailbox.

Notify Me

Notify Me settings are located on the Notify Me Web page in your User Preferences.

The Notify Me feature sends you a notification when you receive a new voice message. You
receive the notification by:

» Text message to your mobile phone.

* Phone call to your mobile phone.

+ Page notification to your pager.

+ Email notification to your email address.

You can also configure the Notify Me settings to send an email notification to your email address
after each successful outbound fax.

© Note:

« If you do not have a Notify Me Web page, notification features have been disabled at the
system administration level. Similarly, if one of the described notification options is not
available, it has been disabled by the administrator.

« Avaya Aura® Messaging supports only email based (SMTP) pager notifications.
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Configuring phone notifications

Before you begin

To enable text message or page notifications you must define a mobile phone or pager number. To
set up your mobile phone or pager number, specify the phone number in the Mobile Phone or
Pager section in General preferences. Messaging supports only email based (SMTP) pager
notifications.

About this task

To configure phone notifications, perform the following steps on the Notify Me Web page of your
User Preferences:

Procedure

1. On the Notify Me Web page of User Preferences, under Phone Notifications select Notify
me when a new voice message arrives.

2. Select one of the following notification options:
a. To receive notifications through a phone call, select With a phone call to:

The system displays the phone number you specified in the Other mobile phone or
pager field on the General webpage.

b. To receive notifications as text message or pager notifications, select With a text
message or page to:

The system displays the phone number you specified in the Other mobile phone or
pager field on the General Web page.

If you choose this option, you must select your service provider from the Mobile
provider drop-down list. Contact your system administrator if the system does not
display your mobile provider in the drop-down list.

c. Select Only for important messages if you want to receive notifications for voice
messages that the caller specifies as important in the respective TUI.

Select Ignore broadcast messages if you want to stop receiving broadcast
messages in your mailbox.

3. Click Save.

Configuring email notification

You can receive an email notification of a new voice message to a specified email account. For
email notifications, the Messaging toolbar is not available. You might have to wait about 10
minutes for your changes to take effect.
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Procedure

1.

On the Notify Me webpage of User Preferences, in Voice Email Notifications, select the
Email me a notification for each voice message check box.

Select Custom subject to customize the subject line of your email notifications. You can
enter up to 80 alphanumeric characters.

You can turn off custom subject lines later by selecting Default subject. The default format
for the subject line is: Voice message from <name or telephone number>.

In the To email address text box, enter the email address to which email notifications
need to be sent.

You can enter up to five email addresses. Use a semicolon to separate addresses.

Select the Include the recording check box if you want to include the recording of the
voice message. For Private messages, the voice message recording may not be included
even if this check box is selected, depending on the system configuration.

Select Only for important messages if you want to receive notifications for voice
messages that the caller specifies as important in the TUL.

Select Ignore broadcast messages if you want to stop receiving broadcast messages in
your mailbox.

Configuring fax email notifications

Before you begin

The administrator must enable the appropriate permissions for you to be able to use fax-related
features.

About this task

You can configure the system to send an email status notification for each outbound fax through
the Notify Me section of the User Preferences Web pages.

Procedure

1.

April 2020

In the Fax Email Notifications section, select the Email me a notification for each fax
message sent check box.

In the To email address field, type an email address to which you want the notifications to
be sent.

. Click Save.
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Notify Me field descriptions

Phone Notifications

To receive text message, call or page notifications you must define a mobile phone or pager
number in the Mobile Phone or Pager section in General preferences. Messaging supports only
email based (SMTP) pager natifications.

Name

Description

Notify me when a new voice
message arrives

The option to allow Messaging to send phone notifications to a specified
mobile phone or pager number on the arrival of each new voice message
to your Messaging mailbox.

The phone notification types are:

* With a phone call to: The phone number where Messaging sends
notifications through a phone call.

+ With a text message or page to: The phone number where
Messaging sends notifications through a text message.

- Mobile provider: The name of the mobile service provider of the
phone number that Messaging uses to send notifications through text
messages.

The options to filter phone notifications are:

+ Only for important messages: The option to receive phone
notifications only for the voice messages that a caller specifies as
important in the TUI.

+ Ignore broadcast messages: The option to stop receiving phone
notifications for broadcast messages.
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Voice Email Notifications

Reach Me

Name

Description

Email me a notification for
each voice message

The option to allow Messaging to send an email notification to a specified
email account on the arrival of each new voice message to your
Messaging mailbox. Messaging does not display the Messaging toolbar,
for email notifications.

The subject line types for the email notifications are:

» Custom subject: The customized subject line of your email
notifications. Accepts up to 80 alphanumeric characters.

» Default subject: The default format for the subject line is: Voice
message from <name or telephone number>.

To email address: The email address where Messaging sends email
notifications. Accepts up to five email addresses, separated by
semicolon.

The options to filter email notifications are:

* Include the recording: The option to receive the recording of the voice
message along with the email notification. For private messages,
depending on the system configuration, Messaging can or cannot
include the voice message recording even if this check box is selected.

» Only for important messages: The option to receive email
notifications only for the voice messages that a caller specifies as
important in the TUI.

* Ignore broadcast messages: The option to stop receiving email
notifications for broadcast messages.

Fax Email Notifications

Name

Description

Email me a notification for
each fax message sent

The option to allow Messaging to send an email status notification to a
specified email account for each outbound fax.

To email address: The email address where Messaging sends email
notifications.

The administrator must enable permission to use the fax-realated options.

Reach Me

Reach Me is an optional feature by which Messaging plays a prerecorded message to callers
when forwarding calls to alternate phone numbers. Using the user preferences on the Reach Me
webpage, you can customize how callers connect with you in any of the following situations:

* You do not answer a call.
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* Your primary extension is busy.

If Messaging does not display the Reach Me option on the User preferences webpage, contact
your system administrator.

Using the following Reach Me criteria, you can customize Messaging to forward incoming calls:

« Caller priority: Forward incoming calls based on caller categories, such as internal callers and
other callers.

+ Call screening: Forward incoming calls after screening the calls by caller name.
* Forwarding numbers: Forward incoming calls to up to three numbers.
» Schedule: Forward incoming calls on specific days and hours.

The AUDIX One-Step Recording feature of Avaya Aura® Communication Manager does not
support the Reach Me feature.

Categorizing callers
About this task

Use this procedure to categorize your callers to manage all your calls in an identical fashion, or
define different call handling actions for internal callers and external callers.

Procedure
1. Navigate to the Reach me webpage.

2. In the Caller Categories section, select one of the following:
 Treat all callers the same

* Distinguish between internal callers and other callers
3. Click Save.

Configuring incoming call handling when treating all callers the
same

About this task

Call handling options depend on how you choose to categorize your callers. You can choose to
treat all callers the same in the manner:

Procedure

1. To configure Reach Me, select from the following options:

» To enable Reach me, select Forward calls to the Reach Me numbers below.
 To disable Reach Me, select Go to voice messaging.
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2. When Reach Me is enabled, you can use call screening. To enable call screening, select

the Before forwarding, ask callers to record their name so | can screen the call check
box.

3. Click Save.

Configuring incoming call handling with other callers
About this task

Options for Call Handling differ depending on how you chose to categorize your users. If you
chose to distinguish between internal callers and other callers, the system presents you with
options to define call handling for internal callers and other callers separately.

Procedure
1. To configure Reach Me for internal callers, select from the following options:
+ To enable Reach Me, select Forward calls to the Reach Me numbers below.
+ To disable Reach me, select Go to voice messaging.
2. To configure Reach Me for other callers, select from the following options:
+ To enable Reach Me, select Forward calls to the Reach Me numbers below.
+ To disable Reach me, select Go to voice messaging.

3. If you want to activate call screening, select the Before forwarding, ask callers to record
their name so | can screen the call check box.

4. Click Save.

Call screening

Call Screening is an optional Reach Me feature, which you can enable from the Call Handling
section of the Reach Me Web page in your User Preferences. When you enable call screening:

* Messaging prompts callers to record their names before forwarding the call to you.

* Messaging plays the recorded name when you receive the forwarded call on the basis of
which you can accept or reject the call.

If you reject the call, Messaging informs the caller that you are unavailable and routes the call to
your Messaging mailbox.

Defining your Reach Me numbers
Before you begin

These settings are applicable only when Reach Me is enabled.
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About this task

With Reach Me enabled, incoming calls can be forwarded to up to three numbers. The Messaging
system tries to reach you at all your Reach Me numbers, by dialing them one at a time, before
forwarding a call to your Messaging mailbox.

To define Reach Me numbers:
Procedure
1. From the drop-down boxes, select the forwarding numbers.

2. For each Reach Me Number, specify a ring threshold. For most phones, 3 rings is a good
choice.

Defining a Reach Me schedule
Before you begin
These settings are applicable only when Reach Me is enabled.

About this task

When you enable Reach Me, you can set up a Reach Me schedule to forward calls during a
certain time period and for specific days of the week. By default, calls are forwarded between 9:00
AM and 5:00 PM, Monday through Friday.

To set up a Reach Me schedule:
Procedure
1. Select Forward calls only between.
2. Select a start and stop time.
3. Select the days that you would like the schedule to be in effect.

The system does not forward calls outside the schedule. If your extension rings and you do
not answer, the call is routed to your mailbox.

Reach Me default settings when re-enabled using the TUI

You can enable or disable Reach Me from the Aria or Audix TUI or by using the User Preferences
Web pages. If you use the TUI to re-enable Reach Me, the system:

* Enables call forwarding to previously defined Reach Me numbers.
» Enables the 'Treat all callers the same' option.
* Disables call screening.

* Enables Reach Me scheduling.
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Testing your Reach Me configuration

After you configure your Reach Me settings, call your extension from a separate phone to
experience exactly what your callers experience. This is important for testing defined ring
thresholds and forwarding settings.

You have successfully configured your Reach Me settings if your test call is forwarded to all
specified phone numbers, one by one and then finally, to your Messaging mailbox.

Reach Me field descriptions

Caller Categories

Name Description
Treat all callers the same Messaging manages the calls from internal callers and external callers
similarly.
Distinguish between Messaging manages the calls from internal callers and external callers
internal callers and other separately.
callers
Call Handling

The options for Call Handling differ depending on how you chose to categorize your users. If you
chose to distinguish between internal callers and other callers, the Messaging presents you with
the options to define call handling for internal callers and other callers separately. The options to
manage unanswered calls on your extension are:

Name Description

Forward calls to the Reach | Messaging forwards an unanswered call to the number you specify in the
Me numbers below Reach Me Numbers section.

» Before forwarding, ask callers to record their name so | can screen
the call: This optional feature prompts callers to record their names
before forwarding a call. Messaging plays the recorded name when you
receive a forwarded call. Based on the caller’s identity you can accept
or reject the call. When you reject a call, Messaging informs the caller
that you are unavailable and routes the call to your Messaging mailbox.

Go to voice messaging Messaging routes the call to your Messaging mailbox.

Reach Me Numbers

When you setup Call Handling to forward an unanswered call to the reach me numbers,
Messaging tries to forward the call up to three specified numbers. Messaging dials the numbers
one at a time, before forwarding a call to your Messaging mailbox.
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Name Description

First The first number that Messaging tries to forward an unanswered incoming
call. The option to specify the reach me number is:
+ other phone

After The ring threshold. After which Messaging either calls the next specified

reach me number or forwards the call to your Messaging mailbox. By
default the ring threshold is 3 rings. The next reach options are:

+ other phone

* go to voice messaging

Reach Me Schedule

When you setup Call Handling to forward an unanswered call to the reach me numbers,
Messaging allows you configure a schedule to forward unanswered calls.

Name

Description

Forward calls only between

Messaging forwards a call during a certain time period and on specific
days of the week. By default, calls are forwarded between 9:00 AM and
5:00 PM, Monday through Friday. Messaging does not forward calls
outside the schedule. If your reach me number rings and you do not
answer, Messaging routes the call to your Messaging mailbox.

My Phone

User preferences on the My Phone Web page allows you to customize your preferences when
using the telephone user interface.

The following user preference features are found on the My Phone Web page:

» Auto play

» Message Playback Order

» Message Playback Speed

* Prompt Level

e Date and Time Announcement

* Voice Recognition for Addressing Preferences

© Note:

If one of the described phone preference features is not available on the My Phone Web
page, it has been disabled by the administrator.
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Auto play

The My Phone webpage only displays the auto play option if you use the CallPilot TUI. If you
select this option:

* The TUI automatically begins playback of messages upon log in. You do not have to press
any keys to initiate listening to messages.

* You define the message playback order on the My Phone webpage.

Message playback order options

You can set the order of the messages in which the TUI plays the messages to you. By default,
the message playback order is set by the administrator. However, you can set your own message
playback order by selecting No from the Use default message playback sequence drop-down
list. Then you can set the following playback order options independently for unread, read, and
saved messages:

* Play newest first to hear messages starting with the newest message first.

* Play oldest first to hear messages starting with the oldest message first.

* Play important messages before others to hear urgent messages first.

» Arrange by sender to hear messages that Messaging sorts by sender name.

© Note:

- The My Phone page displays Arrange by sender option only if your administrator
activates the option for you.

- When you select Arrange by sender option, Messaging sorts in the normal sequence
unless your mailbox has multiple messages from the same sender.

- If the envelope information for the message does not include the name of the sender,
Messaging uses the telephone number of the sender.

Some of the message playback options might not be available for your TUI.

Changing the message playback speed

Before you begin

You must select No from the Use default message playback speed configuration drop-down
list to set your own message playback speed. By default, the message playback speed is set by
the administrator.

About this task

Telephone keypad options are available to speed up or slow down the message during review. By
setting the Message Playback Speed, you can choose a slower or faster default speed at which all
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messages are initially played. After setting a slower or faster default playback speed, the
telephone keypad options are still available to further speed up or slow down an individual
message during review.

Procedure

1. To hear messages at a slower than normal speed, choose one of the following (in order of
slowest to fastest):

* 70%
* 85%
* 90%

2. To hear messages at a faster than normal speed, choose one of the following (in order of
slowest to fastest):

* 125%
* 170%

3. To return to normal speed, select 100%.

Enabling the rapid prompts

About this task

Rapid prompts are a set of short, condensed phone prompts that replace the standard phone
prompts. Because they are much shorter, rapid prompts help you save time. For example, for the
standard prompt 'Message sent. Only your introduction will be heard before the original message',
the corresponding rapid prompt is 'Sent'.

Use rapid prompts only if you are familiar with the standard prompts and do not need to hear
instructions in detail each time you use Messaging. If you cannot see the Rapid Prompts
enabled drop-down under the Prompt Level section on the My Phone page in User Preferences,
your administrator has not setup rapid prompts on the Messaging system or you have not selected
a language that supports rapid prompts on the General page in User Preferences.

Rapid prompts are available for the TUIs only in US English.
To enable rapid prompts on your phone:
Procedure

On the My Phone webpage of User Preferences, select Yes from the Rapid Prompts enabled
drop-down list.

The default value is ByCos for playing the rapid prompts as configured by the administrator.
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Setting the date and time announcement
About this task

The date and time announcement feature is available for the Aria TUI. When you review voice
messages using the TUI, the TUI announces the date and time when the message was received
and then plays the message.

Procedure

To hear the date and time when your voice message was received, select Announce date and
time for each message.

Setting the addressing preferences
About this task

Messaging provides the following options to select recipients for a message:

1. Voice recognition: You can use Voice recognition to select recipients or distribution lists by
speaking their full name (as listed in the internal directory or as defined by you for your
personal lists).

2. Telephone keypad: You can use the telephone keypad to select recipients or distribution
list by using the keypad to spell their name or enter their mailbox number.

Procedure
1. To set your addressing preferences, select one of the following options:

» Select Using voice or keypad to use both voice recognition and the telephone keypad to
select voice message recipients.

» Select Using keypad only to use only the telephone keypad to select voice message
recipients.

© Note:

Some of these features may not be available in your organization. For details, contact your
administrator.

My Phone field descriptions

Auto play
Messaging displays the auto play option only if you use the CallPilot TUI.
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Name

Description

Auto play

The TUI automatically plays the messages upon log in, without having to
press any keys to initiate listening, The TUI plays the messages
depending on the message playback order you define on the My Phone
menu.

Message Playback Order

Name

Description

Use default message
playback sequence

The order of the messages in which the TUI plays the messages to you.
By default, the message playback order is set by the administrator. The
options are:

* Yes: The TUI consider the message playback order as set by the
administrator.

* No: The option to configure your own message playback order.
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Name Description

When reviewing voice The options to configure your own message playback order. The
messages using the phone | message playback order options depend on the following message types:

* For unread messages

- Play newest first : The TUI plays the unread messages starting with
the newest message first.

- Play oldest first: The TUI plays the unread messages starting with
the oldest message first.

- Play important messages before others: The TUI plays the unread
urgent messages first.

- Arrange by sender: The TUI plays the unread messages that
Messaging sorts by sender name.

* For read messages:

- Play newest first : The TUI plays the read messages starting with
the newest message first.

- Play oldest first: The TUI plays the read messages starting with the
oldest message first.

- Play important messages before others: The TUI plays the read
urgent messages first.

- Arrange by sender: The TUI plays the read messages that
Messaging sorts by sender name.

* For saved messages:

- Play newest first : The TUI plays the saved messages starting with
the newest message first.

- Play oldest first: The TUI plays the saved messages starting with th
oldest message first.

(0]

- Play important messages before others: The TUI plays the saved
urgent messages first.

- Arrange by sender: The TUI plays the saved messages that
Messaging sorts by sender name.

° Note:

» Messaging displays the Arrange by sender option only if the
administrator enables permission for your Messaging mailbox.

+ After selecting Arrange by sender option, Messaging sorts the
messages in the normal sequence unless your mailbox has
multiple messages from the same sender.

« If the envelope information for a message does not include the
name of the sender, Messaging uses the telephone number of the
sender.

Some of the message playback options might not be available for your TUI.
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Message Playback Speed

Name

Description

Use default message
playback speed
configuration

The message playback speed in which the TUI plays the messages to
you. By default, the message playback speed is set by the administrator.
The options are:

* Yes: The TUI consider the message playback speed as set by the
administrator.

* No: The option to configure your own message playback speed.

Speed level for playing back
messages

The options to play the messages at a slower than normal speed are:
* 70%

* 85%

* 90%

The options to play the messages at a faster than normal speed:

* 125%

* 170%

The option to play the messages at a normal speed:

* 100%

Telephone keypad options are available to speed up or slow down the
message during review. By setting the Message Playback Speed, you
can choose a slower or faster default speed at which all messages are
initially played. After setting a slower or faster default playback speed, the
telephone keypad options are still available to further speed up or slow
down an individual message during review.

Prompt Level

Rapid prompts are a set of short, condensed phone prompts that replace the standard phone
prompts. Because they are much shorter, rapid prompts help you save time. For example, for the
standard prompt 'Message sent. Only your introduction will be heard before the original message',
the corresponding rapid prompt is 'Sent'.
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Name

Description

Rapid Prompts enabled

The options to enable the rapid prompts on your phone are:

+ ByCOS: The TUI plays the rapid prompts as configured by the
administrator. This is the default value.

* Yes: The TUI plays the rapid prompts as configured by you.
* No: The TUI does not use the rapid prompts.

Use rapid prompts only if you are familiar with the standard prompts and
do not need to hear instructions in detail each time you use Messaging.

For Messaging to display the Rapid Prompts enabled option:
* The administrator must setup rapid prompts on the Messaging system.
* You must select a language that supports rapid prompts.

Rapid prompts are available for the TUIs only in US English.

Date and Time Announce

ment

Name

Description

Announce date and time for
each message

When reviewing voice messages using the TUI, the TUI announces the
date and time when the message was received before playing the
message.

The date and time announcement feature is available for the Aria TUI.

Voice Recognition for Addressing

Messaging provides the following options to select recipients for a message:

Name

Description

Using voice or keypad

The option to use both voice recognition and the telephone keypad to
select voice message recipients

In voice recognition you select recipients or distribution lists by speaking
their full name as listed in the internal directory or as defined by you for
your personal lists.

Using keypad only

The option to select recipients or distribution list by using the keypad to
spell their name or enter their mailbox number

Some of these features may not be available in your organization. For details, contact your

administrator.

Personal Lists

Personal lists are voice message distribution lists. You can use a personal list to send a voice
message to multiple recipients simultaneously.
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You can create multiple personal lists and add users as members in the lists. You can also delete
members from your personal lists. Note that the personal list displays the name and mailbox
number of some members in red. These names are of users who are no longer in the system.

Creating a personal list
Procedure

1.
2.
3.

In the User Preferences webpage, click Personal list.
In the Personal Lists webpage, click Add New List.

In the List name text box, specify a name for your personal list. You can use this name
when addressing an outgoing message.

From the List number drop-down list, select a list number. The list number ranges from 11
to 99.

. In the New member (mailbox) text box, enter the mailbox number of the member that you

want to add to your personal list, and then click Add.
The system displays the Member Name and Mailbox of the newly added member.

Continue adding members until you have all the names you would like to include in your
personal list. The maximum number of members that you can add in a personal list is 100.

Click Save.

The maximum number of personal lists that you can create is 89.

Editing a personal list
Procedure

1.
2.
3.

From the Personal list drop-down list, select the personal list that you want to edit.
Click Edit.

You can perform the following actions:

+ Edit the list name

» Change the list number

* Delete existing members

* Add new members

Editing the list name
Procedure

1.

In the List name text box, type the new name of the list.

2. Click Save.
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Changing the list number
Procedure

1. From the List number drop-down list, select an available new list number for your
personal list.

2. Click Save.

Deleting existing members
Procedure
1. In the Members: list, identify the member you want to delete, and then click Delete.

2. Continue deleting members until you have deleted all the members you would like to
remove from your personal list.

3. Click Save.

Adding new members
Procedure

1. In the New member (mailbox) text box, enter the mailbox number of the member you
would like to add to your existing personal list.

2. Continue adding members until you have added all the members you would like to have in
your personal list.

3. Click Save.

Deleting a personal list
Procedure
1. From the Personal list drop-down list, select the personal list that you want to delete.
2. Click Delete.
3. Click OK to confirm.

Personal Lists field descriptions

Name Description

Personal list The option to use, create, edit, and delete personalized voice message
distribution lists.

List name The name for your personal list. You can use this name when addressing
an outgoing message.

List number The number to identify a personal list. The number ranges from 11 to 99.

The maximum number of personal lists that you can create is 89.
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Name Description

Members * Member Name: The name of the member that you added.

* Mailbox: The mailbox number of the member that you added.

New member (mailbox) The mailbox number of the member that you want to add to your personal
list.

Enhanced Lists

Using enhanced lists, you can add and delete members of enhanced lists defined by the system
administrator. Note that the enhanced list displays the entries of some members in red. These
entries are of users who are no longer in the system.

Messaging displays the Enhanced Lists option in the User Preferences webpage only if the
system administrator adds you to the administrator list for at least one enhanced list.

Editing an enhanced list
Procedure
1. In the User Preferences webpage, click Enhanced Lists.
2. From the Enhanced list drop-down list, select the enhanced list that you want to edit.
3. Click Edit.
4. You can perform the following actions:
* Delete existing members

* Add new members

Deleting existing members
Procedure

1. In the Members list, identify the member you want to delete, and then click Delete.

2. Continue deleting members until you have deleted all the members you would like to
remove from your enhanced list.

3. Click Save.

Adding new members
Procedure

1. In the New member text box, enter the mailbox number or email address of the member
you would like to add to your existing enhanced list.
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2. Continue adding members until you have added all the members you would like to have in
your enhanced list.

3. Click Save.

Enhanced Lists field descriptions

Enhanced Lists

Name Description

Enhanced list The existing enhanced list that you want to edit.

Members The member you want to delete.

New member The mailbox number or email address of the member that you want to
add to the enhanced list.

Messaging displays the Enhanced Lists option, only if the administrator adds you to the
administrator list for at least one enhanced list.

Greetings

Greetings include prerecorded names and messages that the TUIs play to the callers when a call
reaches your voice mail. If you do not want the TUls to play the default Messaging system
greetings, you can customize the following:

* Names: You can record your name to replace the system-generated version of your name.

» Standard Greetings: You can record the following standard greetings for the phone to play to
the callers:

- Personal Greeting: To reply to callers when you cannot answer a call. For example, when
you are away or when your line is busy.

- Extended Absence Greeting (EAG): To inform callers of the reason for not responding to
the calls immediately. For example, when you are away from the office. You can configure
EAG expiry date and time on the Greetings webpage of User Preferences and through the
TUlIs.

© Note:

The AUDIX One-Step Recording feature of Avaya Aura® Communication Manager
does not support the EAG feature.

» Optional Greetings: You can record optional greetings that the phone plays based on a set of
optional rules. For example, you can set up an optional greeting to play during office hours to
all internal callers who get no answer on your phone.
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© Important:
You can set either the Standard Greetings or the Optional Greetings for the TUI to play.

You can record only voice messages. Messaging does not support recording music as
greetings.

To configure your greetings from a TUI, see one of the following documents at the Messaging
User Guides Section at the Avaya Support website:

+ Avaya Aura® Messaging Quick Reference (Aria)

« Avaya Aura® Messaging Quick Reference (Audix®)

+ Avaya Aura® Messaging Quick Reference (CallPilot®)
If you do not know which TUI you use, contact your administrator.
Rules for optional greetings

You can record maximum 9 optional greetings and set individual rule for each recorded greeting.
Messaging directs a call based on the following parameters:

* Internal or external call.
« Business in-hours or out-of-hours call.

You can configure the settings related to business hours on the Greetings page in User
Preferences.

+ Call remains unanswered or the phone is busy.

Messaging selects a greeting based on the order list. Last activated greeting becomes first in the
list. Last deactivated greeting becomes last in the list.

Example: For an incoming call for which Messaging plays optional greetings, Messaging:
* First, checks for the matched parameter.
» Second, looks for the first matched rule in the list of greeting rules.

If appropriate greeting is recorded then Messaging plays the greeting to the caller. If Messaging
does not find any matching rules but finds a personal greeting, Messaging plays the personal
greeting. Otherwise, system greeting is played.

Recording your name
Procedure

1. Log in to User Preferences and navigate to the Greetings page.
2. Click the Record icon in the Recorded Name row.

3. Use the controls in the Recording: Recorded Name section to record, play, and save your
name.
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Configuring standard greetings

You can configure settings for your standard greetings from the Greetings tab on the User
Preferences webpages. Your administrator must enable appropriate permissions for you to use
standard greetings-related features.

Procedure

1. To record your Personal greeting, click the appropriate Record icon on the personal
greeting row.

* Red Record icon: Click to record greeting from your computer. A separate section
Recording: Personal opens on the User Preferences Greetings webpage, to record,
play, rerecord, pause, stop, and save the recorded greeting.

» Green Record icon: Click to record greeting from phone. A separate window opens,
directing you to your phone number associated with the Messaging application.

Once you save a recorded greeting, you can click the Play icon to play the greeting.
 Arrow Play icon: Click to play a recorded greeting on your computer.

» Phone Play icon: Click to play a recorded greeting on your phone. Directs you to the
phone number associated with the Messaging application.

The Aria TUI does not support playing personal greetings by a phone.

2. To activate your Personal greeting, select the Active check box on the personal greeting
row.

3. To activate your Extended Absence greeting, select the Active check box on the extended
absence greeting row.

» Red Record icon: Click to record greeting from your computer. A separate section
Recording: Extended Absence appears on the User Preferences Greetings web page,
allowing you to record, play, rerecord, pause, stop, and save the recorded greeting.

» Green Record icon: Click to record greeting from phone. A separate window opens,
directing you to your phone number associated with the Messaging application.

Once you save a recorded greeting, you can click the Play icon to play the greeting.
» Arrow Play icon: Click to play a recorded greeting on your computer.

* Phone Play icon: Click to play a recorded greeting on your phone. Directs you to the
phone number associated with the Messaging application.

4. If you want a greeting to expire within a certain time limit, select the Enable Expiry check
box, and set the Expiration Date/Time for that greeting.

5. <Optional> If you want Messaging to play your current status before playing the standard
greeting, select the Play status prompt before greeting check box.

6. Click Save.

April 2020 Using Avaya Aura® Messaging 97

Comments on this document? infodev@avaya.com



mailto:infodev@avaya.com?subject=Using Avaya Aura®‎‎ Messaging

Customizing Messaging

Configuring optional greetings

You can configure your optional greetings from the Greetings tab on the User Preferences Web
pages. You can also configure greeting rules, based on which Messaging plays optional greetings
to your callers. The rules are designed on the basis of your availability. Your administrator must
enable appropriate permissions for you to use optional greetings-related features.

Procedure

1. To record Optional Greetings, click the appropriate Record icon on each optional greeting
row.

* Red Record icon: Click to record greeting from your computer. A separate section
Recording: Optional Greeting number opens on the User Preferences Greetings
webpage, to record, play, rerecord, pause, stop, and save the recorded greeting.

» Green Record icon: Click to record greeting from phone. A separate window opens,
directing you to your phone number associated with the Messaging application.

Once you save a recorded greeting, you can click the Play icon to play the greeting.
 Arrow Play icon: Click to play a recorded greeting on your computer.

» Phone Play icon: Click to play a recorded greeting on your phone. Directs you to the
phone number associated with the Messaging application.

2. Activate an optional greeting of your choice by selecting the Active check box for that
greeting.

3. Enter a description for the selected greeting in the Description field.
4. Select a call type from the All / Internal / External drop-down list box.
+ To set the optional greeting to play for all calls, select All.

+ To set the optional greeting to play for internal calls only, select Internal. Messaging
classifies only the systemwide set of users or the mailboxes on the system as internal
callers. In that case, the TUI plays the recorded internal greeting to the internal callers.

+ To set the optional greeting to play for external calls only, select External. Messaging
classifies a caller as an external caller, if the caller does not have a mailbox on the
system. In that case, the TUI plays the recorded external greeting to the external callers.

5. Select a phone status from the All / Busy / No Answer drop-down list box.
+ To set the optional greeting to play for all calls, select All.
 To set the optional greeting to play only when your phone is busy, select Busy.

 To set the optional greeting to play only when a caller gets no answer on your phone,
select No Answer.
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Greetings

6. Select a time zone from the All / Office Hours / Non Office Hours drop-down list box.
The office hours are defined in the Business Hours section.

* To set the optional greeting to play at all times, select All.
* To set the optional greeting to play only during office hours, select Office Hours.

* To set the optional greeting to play only during non office hours, select Non Office
Hours.

7. Click Save.

Defining business hours

Before you begin
These settings are applicable only when greetings are enabled.
About this task

You can customize your business hours and set up the time period on each day, for specific days
of the week. By default, business hours are between 8:00 AM and 6:00 PM, Monday through
Friday.

Procedure
1. On the Greetings tab, set the start and end times for the Business Hours Between fields.

2. Define the days of your work week, by individually selecting the check box adjacent to
each day of the week.

Greetings field descriptions

Names
Name Description
Recorded Name The name you record to replace the system-generated version of your
name for the TUIs to play to the callers when a call reaches your voice
mail.
* Play: Plays the recorded greeting on your computer or on your phone
depending on the icon you click to select the device.
* Record: Records the name on your computer or on your phone
depending on the icon you click to select the device.
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Customizing Messaging

Standard Greetings

Name Description

Personal The personalized greeting you record for callers when you cannot answer
a call. For example, when you are away or when your line is busy.

» Play: Plays the recorded personal greeting on your computer or on your
phone depending on the icon you click to select the device.

* Record: Records the personal greeting on your computer or on your
phone depending on the icon you click to select the device.

+ Active: Activates a personal greeting.

Extended Absence The extended absence greeting informs callers about reason for not
responding to the calls immediately. For example, when you are away
from the office.

* Play: Plays the extended absence personal greeting on your computer
or on your phone depending on the icon you click to select the device.

* Record: Records the extended absence greeting on your computer or
on your phone depending on the icon you click to select the device.

+ Active: Activates a extended absence greeting.
» Enable Expiry: Identifies a greeting to expire within a certain time limit.

« Expiration Date/Time: Allows you to set the time limit for an extended
absence greeting.

Optional Greetings

Name Description

Optional Greetings The optional greetings that the phone plays based on a set of optional
rules. For example, you can set up an optional greeting to play during
office hours to all internal callers who get no answer on your phone.

» Greeting number: Identifies a greeting.
» Description: Describes a greeting.

» Play: Plays the optional greeting on your computer or on your phone
depending on the icon you click to select the device.

* Record: Records the optional greeting on your computer or on your
phone depending on the icon you click to select the device.

+ Active: Activates a extended absence greeting.

» Optional Greeting Rules: Allows you to set optional greeting rules.
- All/Internal/External:
- All/Office Hours/Out of Office Hours:
- All/Busy/No Answer:
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Password

Business Hours

Name Description

Business Hours The time period on each day, for specific days of the week when
Messaging plays a greeting. By default, business hours are between 8:00
AM and 6:00 PM, Monday through Friday.

* Business Hours Between:

* and:

* on:

Password

You can change your Messaging password using:
* User Preferences
« TUI
* Messaging Web Access

Messaging displays the password rules on the Password webpage. If your new password does
not comply with the password rules, Messaging displays an error message.

Changing password using User Preferences
About this task
Use this procedure to change the password for voice messaging using User Preferences.
Procedure
1. On the User Preferences webpage, click Password.
2. In New password, enter a new password.

3. In Confirm new password, re-enter the password to confirm.
4. Click Change.

Changing password using TUI
About this task

To change your password from a phone, refer to one of the following documents:
+ Avaya Aura® Messaging Quick Reference (Aria)
« Avaya Aura® Messaging Quick Reference (Audix®)
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Customizing Messaging

« Avaya Aura® Messaging Quick Reference (CallPilot®)

These guides are available at the Messaging User Guides Section at the Avaya Support Web site.
If you do not know which TUI you use, contact your administrator.

Changing password using Messaging Web Access
Procedure

1. On the Messages page, click Preferences > Password.
2. In New password, enter a new password.

3. In Confirm new password, re-enter the password to confirm.
4. Click Change.

Password field descriptions

Messaging Password

Name Description

New password The new password for your voice Messaging mailbox.

Confirm new password The new password that you confirm for your voice Messaging mailbox.
Advanced

Clearing the mailbox number association
About this task

Use this procedure to reset the association between your Messaging mailbox and your email
identity.

© Note:

Do not to perform this task unless instructed by your administrator or an Avaya Services
technician.

Procedure
1. Log in to the User Preferences webpage.
2. In the navigation pane, click Advanced.

3. On the Advanced Tasks section, click Clear.
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Advanced

Advanced field descriptions

Advanced Tasks

Name Description

Clear the mailbox number The option to reset the association between your Messaging mailbox and
used as your Play on Phone | your email identity.
user identifier
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Chapter 6: Troubleshooting

Troubleshooting the fax issues

Unable to download a fax client installer
Condition
Unable to download a fax client installer.
Solution
Recheck that you are using the correct URL to download the fax client installer.

Unable to add a fax printer service

Condition

When adding a fax printer service as a network printer on a Windows desktop, after typing the
username and password, Messaging displays the following error message:

You do not have access to the printer, please try a different username
or password.

Solution
Contact your system administrator.

Windows fails to connect to a fax printer service

Condition
Windows fails to connect to the added fax printer service.
Solution

Recheck that you enabled the IPP feature on your computer.
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Troubleshooting the teletypewriter user interface

Unable to send a fax
Condition
Messaging displays the error message: Print file failed. rc = 1260.
Solution
Recheck that you enabled the HTTP printing feature on your computer.

A Messaging fax receiver is unable to receive faxes

Condition

A Messaging fax receiver is unable to receive faxes that you are sending.
Cause

The Messaging mailbox of the fax receiver does not have the fax privilege.
Solution

Ask the Messaging fax receiver to contact the administrator.

Troubleshooting the teletypewriter user interface

This topic describes how to correct common problems that can occur on TTY-enabled Messaging
systems. If these suggestions do not correct the problem, contact your administrator.

© Note:

The TUI you use determines the telephone key that you press.

Typographical errors and missing characters in Messaging
messages

Messaging transmissions might not be loud enough for your TTY device.

Potential solution
Procedure

1. On some TTY devices, you can adjust the sensitivity of the device in order to detect weak
signals.

For more information about setting the device sensitivity to high, refer to the user guide for
your TTY device.

April 2020 Using Avaya Aura® Messaging 105

Comments on this document? infodev@avaya.com



mailto:infodev@avaya.com?subject=Using Avaya Aura®‎‎ Messaging

Troubleshooting

2. Alternatively, you can increase the volume of the transmission while Messaging plays a
message. Dial the appropriate telephone key for your TUL.

© Note:

Do not try to increase the volume while Messaging plays prompts, or presents a menu.

Messaging does not respond to your commands or menu
selections

You might be sending “Baudot” TTY tones instead of the “touchtones” that Messaging requires for
command entries and menu selections.

The Baudot tones produced by TTY devices and the touchtones produced by a telephone when

dialing a telephone number are different. Many TTY devices that can generate touchtone signals

to dial telephone numbers switch automatically to TTY mode after dialing the number.
Potential solution

Procedure

Use the TTY device with a standard telephone that is dialpad-equipped, or use the TTY device
with the Avaya IP Softphone.

System does not respond to the telephone keys that you press

While Messaging transmits text to your TTY, the system does not respond to the telephone keys
that you press. In other words, you have to wait until Messaging stops transmitting before it
responds to your touchtone commands.

Messaging transmissions can be so loud that Messaging cannot detect your touchtone signals.
Potential solution
Procedure
1. After Messaging transmits a message, lower the volume of the transmissions.

2. Press the appropriate telephone key for your TUI.

© Note:

Do not try to lower the volume while Messaging plays prompts or presents a menu.
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Troubleshooting the teletypewriter user interface

The TTY displays random characters, numbers, and punctuation
marks rather than meaningful text

Possible cause: Your TTY device is not synchronized with the Messaging system. Specifically,
Messaging is in letters mode while your device is in figures mode.

Potential resolution

About this task

Depending on the type of TTY device you use, you can re-synchronize your TTY device with
Messaging in the following ways:

Procedure
1. Press the Spacebar key.
2. Press the LETTERS key.
3. Type any letter.

© Note:

If you see letters where you expect to see numbers, press the FIGURES key on your
TTY device, or type any digit.

Users see random characters, numbers, and punctuation marks
on recorded messages

When TTY users read a message or a conversation that you recorded using Messaging, they see
random characters, numbers, and punctuation marks.

Possible cause: Your TTY device is not synchronized with the Messaging system.

Potential solution

About this task

To synchronize your TTY device with Messaging, use one of the following methods before you
type in any content:

Procedure

1. If your recording starts with a letter, press the LETTERS key before you type in any
content.

2. If your TTY device does not have a LETTERS key, type a slash (/), press Spacebar a few
times, and type the content.

3. If your recording starts with a figure, press the FIGURES key and type in your content.
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4. If your TTY device does not have a FIGURES key, type the letter x, press Spacebar a few
times, and then type in your content.

© Note:

In all cases, wait for the GA prompt before you start to type.
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Chapter 7: Related resources

Documentation

You can download the documents you need from the Avaya Support website at http://
support.avaya.com. In addition to the documentation listed here, you can download a zip file that
is a compilation of the Avaya Aura® Messaging documentation library. You can install this library

on a computer or on your corporate network.

The Avaya Support website also includes the latest information about product compatibility, ports,
and Avaya Aura® Messaging releases.

Administration

Title

Description

Audience

Administering Avaya Aura®
Messaging

Explains how to use the System
Management Interface (SMI) to
configure your system, use
reports and diagnostic tools,
manage software and users, and
perform routine maintenance
tasks.

The content is available in two
formats: HTML and PDF.

Administrators

Job aid for Administering Avaya
Aura® Messaging

Includes routine administration
tasks. This job aid is a subset of
the administration guide.

Administrators

Avaya Aura® Messaging Alarms
and Events

Describes system alarms, events,
and repair procedures.

Administrators and support
personnel
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Related resources

Overview

Title

Description

Audience

Avaya Aura® Messaging
Overview and Specification

Describes tested product
characteristics and capabilities,
including feature descriptions,
interoperability, performance
specifications, security, and
licensing requirements.

Sales and deployment engineers,
solution architects, and support
personnel.

Avaya Aura® Messaging Single
Server Reference Configuration

Describes the design, capacities,
interoperability, and limitations of
single-server configurations.

Sales and deployment engineers,
solution architects, and support
personnel.

Avaya Aura® Messaging
Multiserver Single Location
Reference Configuration

Describes the design, capacities,
interoperability, and limitations of
multi-server single location
configurations.

Sales and deployment engineers,
solution architects, and support
personnel.

Avaya Aura® Messaging
Multiserver Dual Location
Reference Configuration

Describes the design, capacities,
interoperability, and limitations of
multi-server dual location
configurations.

Sales and deployment engineers,
solution architects, and support
personnel.

Avaya Aura® Messaging
VMware® in the Virtualized
Environment Reference
Configuration

Describes the design, capacities,
interoperability, and limitations of
VMware® in the virtualized

environment configurations.

Sales and deployment engineers,
solution architects, and support
personnel.

Deployment, upgrade, and migration

Title

Description

Audience

Deploying Avaya Aura®
Messaging using VMware® in the
Virtualized Environment

Describes procedures for
deploying the Avaya Aura®
Messaging virtual application in
the Avaya Aura® Virtualized
Environment. The procedures
relate to installation,
configuration, initial
administration, troubleshooting,
and basic maintenance of the

application.

Deployment engineers, solution
architects, and support personnel.
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Documentation

Title Description Audience

Deploying Avaya Aura® Describes procedures for Deployment engineers, solution
Messaging using Solution deploying the Avaya Aura® architects, and support personnel.
Deployment Manager Messaging virtual application in

the Appliance Virtualization
Platform. The procedures relate
to installation, configuration, initial
administration, troubleshooting,
and basic maintenance of the

application.
Security
Title Description Audience
Avaya Aura® Messaging Security | Discusses security issues to Solution architects, deployment
Design consider when designing a engineers, and administrators

corporate security strategy. Topics
include network security, toll
fraud, and recommendations for
maintaining a secure system.

User functions

Title Description Audience

Using Avaya Aura® Messaging Explains how to set up and use Users
User Preferences and the
Messaging toolbar in your email
client.

The content is available in two
formats: HTML and PDF.

Using Avaya Aura® Messaging Includes the most common user | Users and support personnel
Job Aid tasks. This job aid is a subset of
the user guide.
Avaya Aura® Messaging Quick Describes how to use the Aria Users
Reference (Aria) telephone user interface.
Avaya Aura® Messaging Quick Describes how to use the Audix® | Users
Reference (Audix®) telephone user interface.
Avaya Aura® Messaging Quick Describes how to use the Users
Reference (CallPilot®) CallPilot telephone user interface.
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Related resources

Hardware

New installations

Title

Description

Audience

Installing the Dell" PowerEdge™
R620 server

Describes the components,
specifications, and configurations
for this server.

Deployment engineers and
support personnel.

Installing the Dell" PowerEdge™
R630 Server

Describes the components,
specifications, and configurations
for this server.

Deployment engineers and
support personnel.

Installing the HP ProLiant DL360p
G8 server

Describes the components,
specifications, and configurations
for this server.

Deployment engineers and
support personnel.

Installing the HP ProLiant DL360
G9 Server

Describes the components,
specifications, and configurations
for this server.

Deployment engineers and
support personnel.

Maintenance

Title

Description

Audience

Maintaining and Troubleshooting
the Dell™ PowerEdge™ R620
server

Describes how to add, replace,
and repair hardware components
for this server.

Deployment engineers and
support personnel.

Maintaining and Troubleshooting
the Dell" PowerEdge™ R630
Server

Describes how to add, replace,
and repair hardware components
for this server.

Deployment engineers and
support personnel.

Maintaining and Troubleshooting
the HP ProLiant DL360p G8
server

Describes how to add, replace,
and repair hardware components
for this server.

Deployment engineers and
support personnel.

Maintaining and Troubleshooting

Describes how to add, replace,

Deployment engineers and

the HP ProLiant DL360 G9 and repair hardware components | support personnel.
Server for this server.
Training

You can get the following Messaging courses at https://www.avaya-learning.com. Enter the course
code in the Search field and click Go to search for the course.

The course titles might differ from the titles shown.

Course code Course title

4311W

Selling Unified Communication Messaging — Overview
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Viewing Avaya Mentor videos

Course code Course title

5000140V Avaya Aura® Messaging Implementation, Administration, and Support Virtual
Instructor Led

5000140l Avaya Aura® Messaging Implementation, Administration, and Support Instructor Led

ATI01674VEN Avaya Aura® Messaging — Caller Applications

Viewing Avaya Mentor videos

Avaya Mentor videos provide technical content on how to install, configure, and troubleshoot
Avaya products.
About this task

Videos are available on the Avaya Support website, listed under the video document type, and on
the Avaya-run channel on YouTube.

* To find videos on the Avaya Support website, go to http://support.avaya.com and perform one
of the following actions:

- In Search, type Avaya Mentor Videos to see a list of the available videos.

- In Search, type the product name. On the Search Results page, select Video in the
Content Type column on the left.

* To find the Avaya Mentor videos on YouTube, go to www.youtube.com/AvayaMentor and
perform one of the following actions:

- Enter a key word or key words in the Search Channel to search for a specific product or
topic.

- Scroll down Playlists, and click the name of a topic to see the available list of videos
posted on the website.

© Note:

Videos are not available for all products.
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